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Computer Aided Engineering Graphics  
 

Engineering Graphics 
 

Engineering Graphics is the principal method of communication in the field of engineering and 

science . the graphics of engineering design and construction is one among the most important 

courses of all studies for engineering. It is the language used by the designer, technician and 

engineer to communicate, design and construct details to others. 

The Graphic Language 
 

Engineering drawing is the graphic language used by engineers and technologists globally. The 

graphic language may be defined as the graphic representation of physical objects and their 

relationships. This language is written in the form of drawings using straight and curved lines which 

represent the shape, size and specifications of physical objects. The language is read by 

interpreting the drawings so that the physical objects can be constructed exactly as conceived by 

the designer. An engineer, should have proper understanding of the theory of projection, 

dimensioning and conventions related to working drawings, in order to become professionally 

efficient. 

Traditional Drafting 
 

Engineering drawings are made up of straight and curved lines to represent the surfaces, edges and 

centres of objects. Symbols, dimensional values and word-notes are added to these lines so that 

they collectively make the complete description. The traditional drafting is the presentation of 

these drawings manually, by freehand sketching or with the help of drawing instruments. 
 

Computer Aided Drafting 
 

Computer Aided Drafting is a process of preparing a drawing of an object on the screen of a 

computer. There are various types of drawings in different fields of engineering and sciences. In the 

fields of mechanical or aeronautical engineering, the drawings of machine components and the 

layouts of them are prepared. In the field of civil engineering, plans and layouts of the buildings are 

prepared. In the field of electrical engineering, the layouts of power distribution system are prepared. 

In all fields of engineering use of computer is made for drawing and drafting. 

The use of CAD process provides enhanced graphics capabilities which allows any designer to 



• Conceptualize his ideas 
 

• Modify the design very easily 
 

• Perform animation 
 

• Make design calculations 
 

• Use colors, fonts and other aesthetic features 

 

Benefits of CAD 
 

The implementation of the CAD system provides variety of benefits to the industries in design and 

production as given below: 

1. Improved productivity in drafting 
 

2. Shorter preparation time for drawing 
 

3. Reduced man power requirement 
 

4. Customer modifications in drawing are easier 
 

5. More efficient operation in drafting 
 

6. Low wastage in drafting 
 

7. Minimized transcription errors in drawing 
 

8. Improved accuracy of drawing 
 

9. Assistance in preparation of documentation 
 

10. Better designs can be evolved 
 

11. Revisions are possible 
 

12. Colours can be used to customize the product 
 

13. Production of orthographic projections with dimensions and tolerances 
 

14. Hatching of all sections with different filling patterns 
 

15. Preparation of assembly or sub assembly drawings 
 

16. Preparation of part list 
 

17. Machining and tolerance symbols at the required surfaces 
 

18. Hydraulic and pneumatic circuit diagrams with symbols 
 

19. Printing can be done to any scale 

CAD SOFTWARES 

The software is an interpreter or translator which allows the user to perform specific type 

of application or job related to CAD. The following softwares are available for drafting 

1. AUTOCAD 
 

2. CREO 
 

3. CATIA 
 

4. SOLID WORKS 



5. NX Unigraphics 
 

6. FUSION 360 
 

7. INVENTOR 
 

8. SOLID EDGE 
 

The above software’s are used depending upon their application Computer Aided Engineering Graphics 

(CAEG) B.TECH – I YEAR 

Drawing Instruments and aids: 

 
 



is prepared by the help of good quality drawing instruments and other aids. The following are the 
 

 
 
 

• Drawing board 
 

• Setsquares 
 

• French curves 
 

• Templates 
 

• Mini drafter 
 

• Instrument box 
 

• Protractor 
 

• Set of scales 
 

• Drawing sheets 
 

• Pencils 
 

Drawing Sheet: 
 

Engineering drawings are prepared on standard size drawing sheet. The correct shape and size of 

the object can be visualized from the understanding of not only its views but also from the various 

types of lines used, dimensions, notes, scales etc., The standard drawing sheet sizes are arrived at 

on the basic Principal of X:Y =1: √2 and XY=1 where x and y are the sides of the sheet. For 

example, AO, having a surface area of 1Sq.m; X=841mm and Y=1189mm.The successive sizes 

are obtained by either by halving along the length or doubling the width, the area being in the 

ratio1:2. Designation of sizes is given in the fig. For class work use of A2 size drawing sheet is 

preferred.  

Drawing Sheet Layout It is an important function of engineering drawing. Also, it is very important to understand 

the standard for the selection of suitable scale, margin space, title block and part list etc., on the sheet. The 

below mentioned details in the drawing sheet is according to IS 46:2003 

Title Block Title block is to be placed within the drawing space at the bottom right hand corner of the drawing 

sheet and it should be visible when prints are folded. It should consist of one or more adjoining 



rectangles. These rectangles may be divided further into boxes for inserting specific information. 

The size of the title block as recommended by the B.I.S. is 185 mm x 65 mm fro all designations 

of the drawing sheets. All the title blocks should contain at least the particulars mentioned below. 

 

 
 

 
SN Particulars 

1Name of the firm 

2Title of the Drawing 

3Scale 

4Symbol denoting the method of projection 
 

5Drawing number 
 

6Initials with dates of persons who have designed, drawn, checked, 

standards, and approved 

7No. of sheet and total number of sheets of the drawing of the object 
 

The Title blocks used in industries and for class work purpose are shown below.  



 
 

Types of Lines: 
 

1. Outlines (A): Continuous thick or wide lines drawn to represent the visible edges and surface 

boundaries of the objects are called Outlines or Principal Lines. 

2. Margin Lines (A): They are continuous thick or wide lines along which the prints are trimmed 
 

3. Dimension lines (B): these lines are continuous thin lines that are terminated at the outer ends 

by pointed arrowheads touching the outlines, extension lines or centre lines. 

4. Extension or Projection Lines (B): These are also continuous thin lines that extend by about 3 

mm beyond the dimension lines. 

5. Construction Lines (B): These continuous thin light lines used for constructing figures. 
 

 
 
 

of 450 to the main outline of the section and are uniformly spaced about 1mm to 2 mm apart. 

These are used to make the section evident. 

7. Leader or pointer lines (B): It is a continuous thin line drawn to connect a note with the feature 

to which it applies. 

8. Border Lines (B): Perfectly rectangular working space is determined by drawing the border 

lines. 

9. Short- break lines (C): These are continuous, thin and wavy lines drawn freehand and are used 



to show a short break or irregular boundaries. Long-break lines (D): These are thin ruled lines with short zigzags 

within them and are drawn to show the long breaks. 

10. Hidden or dotted lines (E/F): Interior or hidden edges and surfaces are shown by hidden lines. 
 

They are also called as dotted lines. 
 

11. Centre lines (G): These are thin, long, chain lines composed of alternately long and dot lines 

drawn to indicate the axes of cylindrical, conical or spherical objects or details and also to 

show the centres of circles and arcs. 
 

12. Cutting-plane lines (H): The location of cutting plane is shown by this line. It is a long, thin, 

chain line, thick at ends only. 

Line Type Description General Applications 

 

A Continuous thick or Continuous wide Visible outlines, Visible edges, Main representations in diagrams, flow 

charts etc., 

 

B Continuous thin (narrow) Imaginary lines of intersection, Dimensions, Extension, Projection, Leader lines, 

Reference lines, Hatching, Construction lines, Outlines of revolved sections 

 

C Continuous thin (narrow) freehand Limits of partial or interrupted views and sections, if the limit is not a chain 

thin line D 

Continuous thin (narrow) with zigzags Long-break line 

 

E Dashed thick (wide) Line showing permissible of surface treatment 

 

 
 
 
 
 

 

G Chain thin Long – dashed dotted Centre lines, lines of symmetry, trajectories, Pitch circle of holes, Axes H 

Chain F Dashed thin (narrow) Hidden outlines, hidden edges 

thin (narrow) with thick (wide) 

at the ends and at changing of the position 

 

Cutting planes  



 
 
 
 

Conventional Representation of 

Materials 



 
 

 
 
 

 

LETTERING 
 

Lettering is defined as writing of titles, sub-titles, dimensions, and other important particulars on 

a drawing. 

To undertake production work of an engineering component as per the drawing, the size and other 

details are indicated on the drawing. This is done in the form of notes and dimensions. Main 

features of lettering consume more time. Lettering should be done freehand with speed. Practice 

accompanied by continuous efforts would improve the lettering skill and style. 

Size of Letters: 
 

• Size of Letters is measured by the height h of the Capital Letters as well as numerals. 
 

• Standard heights for Capital letters and numerals recommended by BIS are given below: 

1.8, 2.5, 3.5, 5, 6, 10, 14, 20 mm 

Note: Size of the letters may be selected based upon the size of the drawing.  

 



DIMENSIONING 
 

A drawing describes the shape of an object. For complete details of an object, its size description 

is also required. The information like distance between surfaces and edges with tolerance, location 

of holes, machining symbols, surface finish, type of material, quantity, etc., is indicated on the 

drawing by means of lines symbols, and holes. The process of furnishing this information on a 

technical drawing as per a code of practice is called dimensioning. 

Principles of dimensioning 
 

1. Dimensioning should be done so completely that further calculation or assumption of any 

dimension or direct measurement from the drawing is not necessary 

2. Every dimension must be given, but none should be given more than once. 
 

3. A dimension should be placed on the view where its use is shown more clearly. 
 

4. Dimensions should be placed outside the views, unless they are clearer and more easily 

read inside. 

5. Mutual crossing of dimension lines and dimensioning between hidden lines should be 

avoided. Dimension lines should not cross any other line of the drawing. 

6. An outline or a centre line should never be used as a dimension line. A centre line may 

extend to serve as an extension line 

7. Aligned system of dimensioning is recommended. 
 

Elements of dimensioning 
 

1. Projection or extension Line 
 

It is a thin continuous line drawn in extension of an outline. It extends by 3mm beyond the 

dimension line. 

2. Dimension Line 
 

It is a thin continuous line terminated by arrowheads touching the outlines, extension lines or 

centre lines. 

3. Leader line 
 

A leader line is a thin continuous line connecting a note or a dimension figure with the feature 

to which it applies. One end of the leader line terminated either in an arrowhead or a dot. The 

other end of the leader line is terminated in a horizontal line at a bottom level of the first or the 

last letter of the note. It is always drawn at a convenient angle of not less than 300 to the line 

which it touches. 

4. Arrow head or Termination of dimension line 
 

An arrow head is placed at each end of a dimensional line. Its pointed end touches an outline, 
 

an extension line or a centre line. The size of an arrow head should be proportional to the  



thickness of the outlines. The length of the arrowhead should be three times its maximum 

width. Different types of arrowheads can be observed, but closed and filled type of arrowhead 

is widely used in engineering drawing. 

Methods of indicating Dimensions 
 

The two methods of indicating dimensions are: 
 

1. Aligned 

 

 

 
 
 

2. Unidirectional 
 

1. Aligned method 
 

In this method, the dimension is placed perpendicular to the dimension line such a way that it 

may be read from the bottom edge of the right-hand edge of the drawing sheet. The dimensions 



must be placed in the middle and above the dimension line. 

 
 

 
 

 
 
 
2. Unidirectional method 

 

In unidirectional method, all the dimensions are placed in such a Way that they can be read 

from the bottom edge of the drawing sheet. The dimension lines are broken near the middle 

for inserting the dimensions. This is method is generally used on large drawings. 



Arrangement of Dimension lines 
 

The dimensions of an object can be placed according to either Aligned or Unidirectional methods, 

but they are arranged in the followings ways and the selection depends on the design and the 

construction requirements. 

1. Chain dimensioning This type of dimensioning is used only where the possible accumulation 

of tolerances does not endanger the functional requirements of the part.(fig. ) 

 
 

 
 
 

2. Parallel dimensioning 
 

This type of dimensioning is used only where a number of dimensions of a part have common 

datum feature. 



 

 
 
 
 

3. Combined dimensioning 
 

In this a combination of both chain and parallel dimensioning are applied. But, the distance of 

dimension line from the object boundary or nearby dimensions line should be at least 5mm to 

6mm. 

 

 
 

 
4. Superimposed running dimensioning 

 

This type of dimensioning is a simple parallel dimensioning and may be used where there are 

space limitations and where no legibility problems will arise. In this, origin is to be indicated 



appropriately and the opposite end of each dimension line should be terminated only with 

arrow head. 

 
 

 
 
 

5. Dimensioning by coordinates 
 

This type of dimensioning follows the principle of coordinate system of identifying the points. 

This type of dimensioning follows the principle of coordinate system of identifying the points. 

There are three ways of indicating this type of dimensioning. 



b. Browser Download 
 

7. After downloading the file, double click on the installation file, and then click Yesto complete 

the installation. 

8. Now click on Install 
 

9. Check the box I accept the click next 
 

10. For the standalone License type default option, enter the serial key & product key details found 

on the software database for this software version. 

11. Click Install and the Click Finish to complete the installation. 
 

System Requirements 
 

• Operating System : 32 or 64-bit Microsoft Windows/ XP-professional/vista or more 
 

• Processor : Pentium 4 or later 
 

• RAM : 4GB or more 
 

• Graphics Card : 1GB or more/ integrated graphics 
 

• Hard Disk : 20GB free hard disk space available including installation 
 

• Pointing devices : Mouse, digitizer with win tab drive, Keyboard 
 

• DVD ROM : Any Speed (not mandatory) Function Keys 

The keyboard function keys F1-F12 control settings that are commonly turned on and off as we 

work in the product. 

Key Feature Description 
 

F1 Help Displays Help for the active tooltip, command, Palette or 

dialog box. 

F2 Expanded History Displays an expanded command history in the Command 

window 

F3 Object Snap Turns object snap ON and OFF 
 

F4 3D Object Snap Turns additional object snaps for 3D ON and OFF 

F5 Isoplane Cycles through 2D isoplane settings (Top, Right and Left) 

F6 Dynamic UCS Turns automatic UCS alignment with planar surfaces ON 

and OFF 

F7 Grid display Turns the grid display ON and OFF 
 

F8 Ortho Locks cursor movement to horizontal or vertical 
 

F9 Grid Snap Restricts cursor movement to specified grid intervals 

F10 Polar Tracking Guides cursor movement to specified angles 

F11 Object Snap Tracking Tracks the cursor horizontally and vertically from object 

snap locations 



F12 Dynamic input Displays distances and angles near the cursor and accepts 

input as we use Tab between fields 

Note: F8 and F10 are mutually exclusive -turning one On will turn the other OFF.  

User Interface 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

Application Menu 
 

Menus are available through the application button in the upper left corner of the drawing window. 
 

This menu contains the commands used to create, save, print, and manage your drawing.  

Command prompt 
 

The rectangular horizontal window at lower side of the screen is called the command area. The 

instructions given to the computer through keyboard is shown in this area. It important to read the 

command prompt when working with an unfamiliar command. 

To enter a command using the keyboard, type the command name on the command line and press 

Enter or the Spacebar. 



Navigation Bar 
 

The navigation bar is a user interface element where you can access both unified and product 

specific navigation tools. Unified navigation tools are those that can be found across many 

Autodesk products. Product-specific navigation tools are unique to a product. 

Quick access toolbar The Quick Access toolbar, displayed in the Drafting & Annotation workspace, is located at 

the very top of the drawing window next to the Application button. The Quick Access toolbar may be customized 

by adding or removing commands. This is done by right clicking on the toolbar and selecting Customize Quick 

Access toolbar or selecting the arrow at the end of the toolbar. 

The Quick Access toolbar contains the following commands: 
 

• QNew: Opens a new drawing. 
 

• Open: Opens an existing drawing. (Ctrl+O) 
 

 
 
 

• Save: Saves the current drawing. (Ctrl+S) 
 

• Save as: Allows you to save the current drawing under a different name. (Ctrl+Shift+S) 
 

• Plot: Plots or prints the current drawing. (Ctrl+P) 
 

• Undo: Used to undo previous command or actions. 
 

• Redo: Used to redo commands that have been undone. 
 

Drawing area & Cross Hair 
 

 
 
 

drawing area. The cursor moves moves in this area in the form of a cross hair as mouse is moved 

by the user. The cross hair position is indicated by coordinate values shown at the left end of the 

status bar. 

View Cube 
 

The View Cube is a navigation tool that allows you to switch between viewing directions. While 

this is very useful in 3D space, it is not very useful in 2D space. It is located in the upper right 

corner of the drawing area. Status bar 

The status bar displays the cursor location, drawing tools, and the tools that affect the drawing 

environment. It also provides quick access to some of the most commonly used drawing tools, 

Coordinates of the cross hair (Cursor) and we can toggle the settings such ads grid, snap, polar 

tracking and object snap. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Draw Commands 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Point: 

 

The Point command will insert a point marker in your drawing at a position which you pick or 

at any coordinate location which you enter in the Command window. Other ways of defining 

a point can be accessed through the fly-out menu. The default point style is a simple dot, which  



is often difficult to see but you can change the point style to something more easily visible or 

elaborate using the point style dialogue box. 

Tool Bar: Menu → Draw → Point Command: Point (PO) 
 

2. Line: 
 

Creates a straight line segment. It is used to draw lines continuously. Each segment is a line 

object that can be edited separately. 

Continue: Continues a line from the endpoint of the most recently drawn line. 
 

Close: End the line segment at the beginning of the first line segment, which forms a closed 

loop of line segment. 

Undo: Erases the most recent segment of a line sequence. 
 

Tool Bar: Menu → Draw → Line Command: Line (L) 
 

3. Construction Line (XL): 
 

The construction line (XLINE) command creates a line of infinite length which passes through 

two picked points. Construction lines are very useful for creating construction frameworks or 

 

 
 
 

 
usual to draw all your construction lines on a separate layer which will be turned off or frozen 

prior to printing. 

Construction line options 
 

• Hor: Creates a horizontal construction line. 
 

• Ver: Creates a vertical construction line. 
 

• Ang: Creates a construction line at a specified angle. 
 

• Bisect: Create a construction line that bisects an angle defined by 3 points. 
 

• Offset: Creates a construction line that is offset from an existing line by a specified 
 

• distance. 
 

Tool Bar: Menu → Draw → Xline Command: Xline (xl) 
 
 

4. Polyline (Pline): 
 

The PLINE command differs from the LINE command in that the segments of the PLINE are 



connected. When using the LINE command, each segment is its own object. When using 

PLINE, all line segments are one object. 

Tool Bar: Menu → Draw → PolylineCommand: Pline (PL) 
 

5. Polygon 
 

A polygon of sides ranging from 3 to any number can be drawn using Polygon command. It 

creates an equilateral closed polyline. 

 

 
 
 
 

Centre of Polygon: Defines the center of the polygon. 
 

Inscribed in Circle: Specifies the radius of a circle on which all vertices of the polygon line. 

Circumscribe about circle: Specifies the distance from the centre of the polygon to the 

midpoints of the edges of the polygons. 

Edge: Defines a polygon by specifying the endpoints of the first edge. 
 

Specifying the radius with your pointing device determines the rotation and size of the polygon. 

Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation 

angle. 

Tool Bar: Menu → Draw → PolygonCommand: Polygon 
 

6. Arc 
 

This command is used to draw an arc accurately. To create an arc, a combination of centre, 

endpoint, start point, radius, angle, chord length, and direction values can be specified. Arcs 

are drawn in a counter clockwise direction by default. 

Start Point:Draws an arc  
 

Tool Bar: Menu → Draw → ArcCommand: Arc 



 
 

7. Circle 
 

There are many ways to draw a circle, the default being the centre point of circle and radius. 

Below are the possible ways of drawing the circle. 

i. Centre point and Radius: Defines the radius of the circle. 

 

 
 
 

ii. Centre point and Diameter: Defines the diameter of the circle. 

 
 

 
 

 
iii. 3P (Three Points): Draws a circle based on three points on circumference. 



 

 
 
 

 
iv. 2P (Two Points): Draws a circle based on two endpoints of the diameter. 

 

v. Tan, Tan, Tan: Creates a circle tangent to three objects.  
vi. Tan, Tan, Radius: Creates a circle with a specified radius and tangent to two objects. 

 

Sometimes more than one circle matches the specified criteria. The program draws the 

circle of the specified radius whose tangent points are closest to the selected points. 

Tool Bar: Menu → Draw →CircleCommand: Circle (C) 

Ellipse 

The Ellipse command gives you a number of different creation options. The default option is 

to pick the two end points of an axis and then a third point to define the eccentricity of the 

ellipse. 

Tool Bar: Menu → Draw →EllipseCommand: Ellipse (E) 

 

 
8. Donut 

 

The DONUT is a special type of polyline which is made up of arc segments. A DONUT has two properties: it has 

width, and it is closed. The width of DONUT is set by specifying inside and outside diameters. The inside 

diameter may be zero thereby making it a filled circle. 

9. Hatch patterns 
 

The HATCH command is used to fill up the area using a suitable pattern. The type of pattern and pattern 

variables can be chosen from a library of patterns available. The hatching will be carried out inside a closed 

defined area. 



 
 
 
 
 

Tool Bar: Menu → Draw →HatchCommand: Hatch (H)  

10. Text 
 

Words, messages and numbers can be inserted as required on an engineering drawing. The alphanumeric 

keyboard is used extensively for non-graphical input such as text. The text style, height, text angle, aspect ratio, 

colour, etc. are some of the attributes associated with text. These attributes can be changed as per requirements. 

11. Rectangle 
 

Creates a rectangular polyline. With this command, the parameters (length, width, rotation) 

can be specified control the type of corners (fillet, chamfer, square). 

Tool Bar: Menu → Draw → RectangleCommand: Rectang (R) 

Drafting Aids 

1. Limits 
 

Drawing limits are used to set the boundaries of the drawing. The drawing boundaries are 

usually set to match the size of a sheet of drawing paper. This means that when the drawing is 

plotted and a hard copy is made, it will fit on the drawing paper. 

 

Command: Limits 
 

Specify lower left corner or [ON/OFF] <0,0>: Specify a point 

Specify upper right corner or <12,9>: Specify a point 

Note: Limits has no limit, it can be infinity with respect to paper size 
 

2. Layers 
 

A layer is like a clear piece of paper that can be laid directly over the drawing. We can draw on the layer and see 

through it to the original drawing. Layers can be made invisible, and information can be transferred between 

layers. Layers are used to control the visibility of objects and to assign properties such as color and linetype. 

Objects on a layer normally assume the properties of that layer 



 
 
 

 
 
 

3. Dimensioning 
 

Create several types of dimensions and save dimension settings by name. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Linear Dimensions horizontal, vertical, aligned, and radial dimensions can be created with the DIM command. 

The type of dimension depends on the object that is selected and the direction of dimension line. 

Dimension Styles Dimension styles help establish and enforce drafting standards. There are many dimension 

variables that can be set with the DIMSTYLE command to control virtually every nuance of the appearance and 

behavior of dimensions. All these settings are stored in each dimension style. The  

default dimension style is named either Standard (imperial) or ISO-25 (metric). It is assigned to 



 
 
 
 
4. Object snap 

 

Object snap provide a way to specify precise locations on objects whenever you are prompted 



 
 
 
 

for a point within a command. With running object snap(Osnap) settings, a snap point at an 

exact location on an object can be specified. When more than one option is selected, the 

selected snap modes are applied to return a point closest to the center of the aperture box.  

Object Snap ON (F3) 
 

Turns running object snaps ON and OFF. The object snaps selected under Object Snap Modes are active while 

the Osnap mode in ON. 

 

 
 

 
Object Snap Tracking On (F11) Turns object snap tracking ON and OFF. With object snap tracking, the cursor 

can track along alignment paths based on other object snap points when specifying points in a command. 



Object Snap Modes: 

 

 
 

 
Snaps to the closest endpoint of an arc, elliptical arc, line, multiline, polyline segment, spline, 

region or to the closest corner of a trace. Solid or 3D face. 

 
 

 
Midpoint Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multiline, polyline segment, region, solid, 

spline or xline. 

 

 
 

 
Center Snaps to the center of an arc, circle, ellipse, or elliptical arc. 

 

 
 

 
Quadrant Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc. 

 

Intersection Snaps to the intersection of an arc, circle, ellipse, line, multiline, polyline, spline, or xline and other 

geometrical objects. Extended intersections are not available as a running object snap.  

Extension It causes a temporary extension line or arc to be displayed when the cursor is passed over the 

endpoint of objects, so that points can be specified on the extension. 

Insertion Snaps to the insertion point of an attribute, a block, a shape, or text. 
 

Perpendicular Snaps to a point perpendicular to the selected geometric object. Deferred Perpendicular snap 

mode is automatically turned on when the object you are drawing requires that more than one perpendicular snap 

can be completed. An object such as a line, arc, 

 



Tangent Snaps to the tangent of an arc, circle, ellipse, elliptical arc, polyline arc, or spline. Deferred Tangent snap 

mode is automatically turned on when the object that is being drawn requires and complete more than one 

tangent snap. It can be used to draw a line or xline that is tangent 

 

 
 

 
Apparent Intersection Snaps to the visual intersection of two objects that do not intersect in 3D space but may 

appear to intersect in the current view. 

Nearest Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, ray, spline 

or xline. 

Parallel Constraints a line segment, polyline segment, ray or xline to be parallel to another linear object. The 

parallel object snap is to be specified, after specifying the first point of a linear object. 

 

 
 

 
Select All Turns on all running object snap modes. 

Clear All Turns off all running object snap modes. 

5. Zoom The objects viewed in the drawing area can be zoomed in or out, and moved to see different 

portions of the sheet in detail by using the following commands: 

The zoom flyout of standard tool bars has nine icons to opt. 
 

a) Zoom window: This command enlarges a rectangular area of a drawing based on a defined 

window using the cross hair 

b) Zoom all: This command displays the are of the drawing limits or extent whichever are 

greater. 

c) Zoom dynamic: Pans and zooms using a rectangular view box. 
 

d) Zoom scale: Zooms to change the magnification of a view using a scale factor. 
 

e) Zoom center: Zooms to display a view defined by a center point and a magnification value 

or a height. 

f) Zoom Object: Zooms to display one or more selected objects as large as possible and in 

the center of the view. 

g) Real Time: Zooms interactively to change the magnification of the view. 
 

h) Zoom extends: Zooms to display the maximum extents of all objects. 
 

i) Zoom Previous: Zooms to display the previous view. You can restore up to 10 previous 

views. 



Out of these “Zoom window” and “Zoom all” command are more useful. Similarly, “Zoom real time”, “Pan real 

time” and “Zoom previous” commands are also frequently applied for drafting 

Editing Commands (Modify Commands) 
 

 

 

 
 
 

1. Move 
 

The Move command works in a similar way to the COPY command except that no copy is 

made; the selected object(s) is simply moved from one location to another 

Tool Bar: Menu → Modify→ Command: explode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Rotate 
 

The Rotate command allows an object or objects to be rotated about a base point selected and 

the angle can be typed in the command prompt by the user. 

Tool Bar: Menu → Modify→ 



Command: explode 
 

3. Copy 
 

The Copy command can be used to create one or more duplicates of any object(s) which have 

been previously created. 

Tool Bar: Menu → Modify→ 
 

Command: explode  
 

4. Mirror 
 

The Mirror command allows you to mirror selected objects in your drawing by picking them 

and then defining the position of an imaginary mirror line using two points. To create perfectly 

 
 

 

 
 
 

 
Tool Bar: Menu → Modify→ Command: explode 

 

5. Array 
 

The Array command makes multiple copies of a selected objects in a rectangular pattern 

(columns and rows) or a polar (circular) pattern or a along a path that is defined. 

 



 
 
 
 

Tool Bar: Menu → Modify→ Command: explode 
 

6. Erase 
 

The Erase command is one of the simplest AutoCAD commands and is one of the most used. 

The command erases or deletes any selected object(s) from the drawing. 

 
 

 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode  
 

7. Break 
 

The Break command helps to break (remove a part of) an object by defining two break points. 

 
 



 
 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode 
 

8. Fillet 
 

The Fillet command is a very useful tool which allows to draw a tangent arc between two 
 

 
 
 

separation cannot be more than the fillet radius. 

 
 

 
 
 

 
Tool Bar: Menu → Modify→ 

 

Command: explode 
 

9. Chamfer 
 

The Chamfer command creates an angled corner (Chamfer) between any two non-parallel lines 

 



 

 
 
 
 

 

Tool Bar: Menu → Modify→ Fillet 
 

→ 
 

Command: explode  
 

10. Extend 
 

The Extend command is used to extend a line, polyline or arc to meet an already existing object. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Tool Bar: Menu → Modify→ 



Command: explode 
 

11. Offset 
 

The OFFSET command creates a new object parallel to or concentric with a selected object. 

The new object is drawn at a user defined distance (the offset) from the original and in a 

 

 

 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode 
 

12. Stretch 
 

The STRETCH command can be used to move one or more vertices of an object while leaving 

the rest of the object unchanged 

 



 
 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode  
 

 
 
 

The Trim command is used to trim off the part of an object that is not necessary. In order to 

trim an object, a second object which forms the cutting edge must be drawn. Cutting edges can 

 

 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode 
 

14. Scale 
 

The Scale command can be used to change the size of an object or group of objects. It allows 

to shrink or enlarge the already existing drawing objects about a base point on specifying the 

 



 
 
 
 

Tool Bar: Menu → Modify→ Command: explode 
 

15. Explode 
 

This command is used to break a single compound object into their constituent parts. In other 
 

 
 
 

command is used to return blocks, polylines, rectangles, etc., 

 

 
 
 

Tool Bar: Menu → Modify→ 
 

Command: explode Quick access toolbar 

The Quick Access toolbar, displayed in the Drafting & Annotation workspace, is located at the 

very top of the drawing window next to the Application button. The Quick Access toolbar may be 

customized by adding or removing commands. This is done by right clicking on the toolbar and 

selecting Customize Quick Access toolbar or selecting the arrow at the end of the toolbar. 

The Quick Access toolbar contains the following commands (reading left to right): 
 

• QNew: Opens a new drawing. 
 

• Open…: Opens an existing drawing. (Ctrl+O) 
 

• Save: Saves the current drawing. (Ctrl+S) 
 

• Save as: Allows you to save the current drawing under a different name. (Ctrl+Shift+S) 
 

• Plot…: Plots or prints the current drawing. (Ctrl+P) 



• Undo: Used to undo previous command or actions. 
 

• Redo: Used to redo commands that have been undone 
 

Starting a new Drawing 
 

When starting a new drawing (QNEW), you have a choice of either starting from the Create New 

Drawingwindow or the Select Templatewindow. The Create New Drawingwindow allows you 

to set up a drawing to your preferences. You may set parameters such as the units (Imperial or 

Metric), the size of the drawing, and the degree of precision. The Select Templatewindow allows 

you to choose from predefined templates. Figure 2.5-1 shows both startup windows. The 

STARTUPvariable is used to choose what is displayed when the application is started, or which 

window will appear when you start a new drawing. It has 4 values that may be set (i.e., 0, 1, 2, and 

3). However, for starting a new drawing, only 0 and 1 are of interest. If STARTUP = 0, then the 

Select Templatewindow will appear. If STARTUP = 1, then the Create New Drawingwindow 

will appear. 
 

Template drawings store all the settings for a drawing and may also include predefined layers, 

dimension styles, and views. Template drawings are distinguished from other drawing files by the 

.dwt file extension. Several template drawings are included in AutoCAD®. You can make 
 

additional template drawings by changing the extensions of drawing file names to .dwt. Computer Aided 

Engineering Graphics (CAEG) B.TECH – I YEAR 
 

 
 
 

Starting a new drawing using the Create New Drawing window Command: startup Enter new value for 

STARTUP <0>: 1 Quick Access toolbar or Application button: File – New…(Ctrl+N). The Create New Drawing 

window will appear. 4) Create New Drawing window: Activate the Start from Scratch button, activate either 

Imperial or Metric toggle, and then select OK 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5) Quick Access toolbar: 
 

6) Create New Drawing window: 
 

a. Activate the Use a Wizardbutton. 
 

7) Select a Wizard field: Select Advanced Setupand then OK.  

8) The wizard will take you through a setup which will allow you to choose your drawings nits, 

angle, angle measure, angle direction and drawing area. 

Saving and opening a drawing 
 

When saving (or open) a drawing (Applicationbutton -Saveor Saveasor Open), 

you have the option of saving (or opening) the following file types. 

• DWG(DraWinG) is a binary file format used for storing two- and three-dimensional design 

data and metadata. Most of what you draw will be saved in this format. 

• DWTis a template file. These files are used as a starting point when starting a new drawing. 
 

They may contain drawing preferences, settings, and title blocks that you do not want to create 

over and over again for every new drawing. 

• DXF(Drawing Interchange Format, or Drawing Exchange Format) is a CAD data file format 



developed by Autodesk® for enabling data interoperability between AutoCAD® and other 

programs. 

• DWSis a standards file. To set standards, you create a file that defines properties for layers, 

dimension styles, linetypes, and text styles, and you save it as a standards file with the .dws 

file name extension. 

 
 
 
 

Plotting of Drawings To print a drawing, click on the icon ‘Plot’. This opens a dialogue box having two pages, 

namely ‘Plot device and Plot Settings’. The plotter configuration or its equivalent has to be selected in the Plot 

Device page. And the following options to be set in the Plot setting page 

Page Size : A4 (210x297 mm) or A3 or etc., 

Units : Mm 

Drawing Orientation : Portrait / Landscape 

Plot Area : Limits 

Plot Scale : 1:1 
 

By clicking on the Full preview button, the area of the figure to printed will be projected. Click OK if it has a 

suitable orientation to start printing.  

Geometrical Constructions 

Introduction: Engineering drawing consists of a number of geometrical Constructions. A few methods are 

illustrated here without mathematical proofs. 

1. To divide a straight line 65 mm into a given number of equal parts say 5. 



 
 
 
 

Solution 1. Draw a line of 65 mm with Command L 2. Name the Line With Text Command A,B 3. To Divide line 

Type Command DIV Enter 4. Select Object To Divide Select Line 5. Enter the Number Of Segment of 5 Enter 6. 

Select Point Style from utilities to show divisions. 

2. To bisect a given angle 900 



Solution 1. Draw a line of 50 mm with Command L Name the Lane With Text Command A,B 2. Draw another 

Line 50 mm From the End of Previous Line with 900 Angle with Command 

L name the Line With Text Command B,C 3. To Bisect Line Type Command XL press enter 4. Select Bisect 

Option or Enter Band specify angle vertex point at End Point. 5. Specify Angle Starting Point 6. Specify angle end 

point enter 7. Mention Angle After Bisection  

Polygons 
 

1. To construct a regular polygon (say a pentagon) given the length of the side 5(EDGE 

METHOD) 

Solution 1. To construct any polygon Enter Command POL 2. Enter No of Sides 5 3. Specify Center pf Polygon 

or Edge enter Command E 4. Specify First End Point of Edge & Specify second End Point of Edge by entering 

specific 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Distance 5 5. Name the Edges With text Command TEXT 



 

 
 
 
 

Solution 
 

1. To construct any polygon Enter Command POL 
 

2. Enter No of Sides 6 
 

3. Specify Center of Polygon or Edge enter select Center 
 

4. Enter an option with Inscribed in Circle with command I 
 

5. Specify radius Of Circle with 50 
 

6. Name the Edges With text Command TEXT 

Practice Exercises 

1. Divide an 80 mm long straight line into five equal parts. 2. Divide a 90 mm long straight line into parts that are 

in proportion to 2:3:5. 3. Draw a perpendicular to a 100 mm long line AB, at a point P lying on the line at a 

distance of 

40 mm from the end A. 4. Draw a 120 mm long line AB inclined at 60° to the horizontal. Erect a perpendicular to 

AB 

from point P, lying at a distance 30 mm from end A. 5. Draw perpendicular to a 100 mm long line AB, from a point 

P lying at a distance 60 mm from 

end A and 70 mm from end B. 6. Draw a line AB inclined at 30º to the horizontal. Draw another line CD parallel to 

and 50 mm 



 
 
 

 

1. To construct a regular polygon (say a pentagon) given the length of the 

side 40mm (GENERAL METHOD) 
 

Solution: 

1. Draw lines AB AND BC with lengths of 40mm using Line command L. Draw a line 

joining A and C using Line command L. Mark the text using MTEXT command. 
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2. Draw a circle with 40mm radius and B as centre using Circle command C. Trim the 

extra portion of circle using Trim command TR. 
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3. Create a bisecting line at a distance of 20mm from BC using Offset command O. 

4. Mark point 4 at the intersection of AC and bisecting line and 6 at the intersection of arc and 

bisecting line. Mark the points using MTEXT command. 

5. Create a point at the midpoint of 4 and 6 using Offset command O. Mark the point as 5 using 

MTEXT command. 

6. With offset command O, Create a line at 8 with distance equal to 4-6. 

5. Create a point at the midpoint of 6 and 8 using Offset command O. Mark the point as 7 using 

MTEXT command. 
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6. With A5 radius, 5 as centre draw a circle using Circle command C. 

7. With AB radius, A as centre draw an arc on circle using Circle command C. Mark a 

point 1 at the intersection of two circles using MTEXT command. 

8. Using above procedure, draw arcs 2, 3 for pentagon shape. Center for 2 arc is 1 

and center for3 arc is 2. 
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9. Join points A-1, 1-2, 2-3, 3-B using Line command L. 

10. Final diagram is the pentagon shape. 
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2. To construct a regular polygon Hexagon given the length of the side 

40mm (GENERAL METHOD) 
 

Solution: 

1. Draw lines AB AND BC with lengths of 40mm using Line command L. Draw a line 

joining A and C using Line command L. Mark the text using MTEXT command. 
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2. Draw a circle with 40mm radius and B as centre using Circle command C. Trim the 

extra portion of circle using Trim command TR. 
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3. Create a bisecting line at a distance of 20mm from BC using Offset command O. 

4. Mark point 4 at the intersection of AC and bisecting line and 6 at the intersection of arc and 

bisecting line. Mark the points using MTEXT command. 

5. Create a point at the midpoint of 4 and 6 using Offset command O. Mark the point as 5 using 

MTEXT command. 

6. With offset command O, Create a line at 8 with distance equal to 4-6. 

5. Create a point at the midpoint of 6 and 8 using Offset command O. Mark the point as 7 using 

MTEXT command. 
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6. With A6 radius, 6 as centre draw a circle using Circle command C. 

7. With AB radius, A as centre draw an arc on circle using Circle command C. Mark a 

point 1 at the intersection of two circles using MTEXT command. 
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8. Using above procedure, draw arcs 2, 3, 4 for Hexagon shape. Center for 2 arc is 1, 

center for 3 arc is 2 and center for 4 arc is 3. 

9. Join points A-1, 1-2, 2-3, 3-4, 4-B using Line command L. 

10. Final diagram is the Hexagon shape. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

DEPARTMENT OF MECHANICAL 
ENGINEERING 



 
 
 
 
 
 
 
 
 
 
 
 

CONIC 

SECTIONS 

 
DEPARTMENT OF MECHANICAL 

ENGINEERING 



 

 
 

ELLIPSE: 

CONIC SECTIONS 

 

• The Ellipse may defined as the locus of a point moving in a plane in such a way 

• That the ratio of its distances from a fixed point and a fixed straight line is always 

• Constant. And It Less than one e<1 

• Ellipses are mostly found as harmonic oscillators, phase visualization, elliptical gears, Ellipse 

wings. 
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Draw an ellipse with the distance of the focus from the directrix at 50 mm 

and Eccentricity =2/3 Also draw a tangent and a normal to the ellipse at 

a point 40 mm from the directrix. (Eccentricity method) 
 

Solution: 

1. Draw A Vertical Line AB Called Directrix Using Line Command L with Some 

Height and F8 on, mark AB on vertical line using Text command 
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2. At Any point C In the Directrix Draw Horizontal Line CD called Axis with Some Length using Line 

command L and F8 on, mark CD on horizontal line using Text command Mtext 
 
 
 
 
 
 
 
 
 
 
 
 

3. Mark a Focus point F on the Axis Making Offset 50 mm Distance From Directrix line CF=50 mm 

using Offset command O 
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4. Mark a Vertex (V) on CD at a distance of 20 mm from F, because e = 2/3 (e<1) (e= VF/VC) using 

Offset command O 

5. Mark distances of VF = 20mm and VC = 30mm using Dimension command DIMLIN 
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E with 20 mm distance FROM V ( 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

6. Mark a point VF perpendicular to VE) 
 
 

 
7. Draw a line, joining C and E and extend up to some length using Line 

command L. 
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8. Draw a line from F with 45° using line Command. (both CE extension line and 

45° line must coincide). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Divide VD line into number of equal 

parts using Offset command O. 
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10. Mark numbers 1,2,3, etc. on VD line and mark as 1,ɪ 2,ɪetc. at the 

intersection points of CE extension line and offset lines. 
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• 11. Measure the distance between 1to 1’ Using 

MEASURE (MEA) command. 

• 12. Draw the circles with F as centre by taking distance 1to1’,2 to 2’ 

…12 to 12’ to etc. as radius using Circle command C. 

• 13. Create the points at the intersection of circle and 1-1' ,eɪ tc.. 

line above and below CD line using point command PO. 
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14. Mark the points P 1, P 2, etc. and P 1ᶦ,P ɪ 2, etc… on both sides of 

CD line for developing Ellipse. 
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• 15. Mark a point P ON ELLIPSE at a distance of 40 mm from 

directrix using offset command O. 
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• 16. Draw a line by joining P and F, Draw a line from F perpendicular to the 

directrix using line command L. Mark a point T on Directrix line. 

• 17. Make lines FP and FT perpendicular, select parametric from MENU 

BAR - geometric constraints - perpendicular - Select two lines 
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• 18. Draw a Tangent line by joining from T to P and extend some 

distance and mark as Tɪ 
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• 19. Draw a Normal line to Tangent line TTɪ and extend some distance and 

mark as NNɪ 

• 20. Make lines TTɪ and NNɪ perpendicular, select parametric from MENU 

BAR - geometric constraints - perpendicular - Select two lines. 
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• PARABOLA: 

CONIC SECTIONS 

• The Parabola may defined as the locus of a point moving in a plane in such a way that the ratio of 

its distances from a fixed point and a fixed straight line is always constant. And It always equal to 

one e=1 

• In physical world, parabola are found in the main cables on simple suspension bridge, as 

parabolic reflectors in satellite dish antennas, vertical curves in roads, trajectory of a body, 

automobile headlight, parabolic receivers. 
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Draw a parabola with the distance of the focus from the directrix at 50mm 

Also draw a tangent and a normal to the parabola at a point 60 mm from 

the directrix. (Eccentricity method) 

Solution: 

1. Draw A Vertical Line AB Called Directrix Using Line Command L with 

Some Height and F8 on, mark AB on vertical line using Text command 

2. At Any point C In the Directrix Draw Horizontal Line CD called Axis with 

Some Length using Line command L and F8 on, mark CD on horizontal 

line using Text command Mtext 
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3. Mark a Focus point F on the Axis Making Offset 50 mm Distance 

From Directrix line CF=50 mm using Offset command O. 
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4. Mark a Vertex (V) on CD at a distance of 25 mm from F, because e 

= 1 (e= VF/VC) 

5. Mark distances of VF = 25mm and VC = 25mm using Dimension 

command DIMLIN 
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6. Mark a point E with 25 mm distance FROM V (VF perpendicular to VE) 
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7. Draw a line, joining C and E and extend up to some length using Line 

command L and Extend command EX. 
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8. Divide VD line into number of equal parts using Offset command O. 

9. Mark numbers 1,2,3, etc. on VD line and mark as 1ɪ, 2 ,ɪetc. at the 

intersection points of CE extension line and offset lines. 
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10. Measure the distance between 1 to 1ᶦ,2 to 2,ɪ etc.. Using MEASURE 

(MEA) command. 

11. Draw the circles with F as centre by taking distance 1 to 1ᶦ,2 to 2ᶦ,etc.. as 

radius using Circle command C. 
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12. Create the points at the intersection of circle and 1-1 ᶦ,2 - 2,ɪ etc.. line above 

and below CD line using point command PO. 

13. Mark the points P 1, P 2, etc..and P 1ᶦ,P 2ɪ , etc… on both sides of CD line for 

developing Parabola. 
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14. Draw curve using Spline Command SPL. 
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15. Mark a point P on Parabola at a distance of 60 mm from directrix using 

offset command O. 
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16. Draw a line by joining P and F, Draw a line from F perpendicular to the 

directrix using line command L. Mark a point T on Directrix line. 

17. Make lines FP and FT perpendicular, select parametric from MENU BAR 

geometric constraints perpendicular Select two lines 
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18. Draw a Tangent line by joining from T to P and extend some distance and 

mark as Tɪ 
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19. Draw a Normal line to Tangent line TTɪ and extend some distance and 

mark as NNɪ 

20. Make lines TTɪ and NNɪ perpendicular, select parametric from MENU 

BAR - geometric constraints – perpendicular - Select two lines. 
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CYCLOIDAL CURVES 
• CYCLOID: 

• In geometry, a cycloid is the curve traced by a point on a circle as it rolls along a straight line 

without slipping. 

• A cycloid is a specific form of trochoid and is an example of a roulette, a curve generated by a 

curve rolling on another curve. 

• Cycloid, the curve generated by a point on the circumference of a circle that rolls along a straight 

line. If r is the radius of the circle and θ(theta) is the angular displacement of the circle, then the 

polar equations of the curve are x = r(θ- sin θ)and y = r(1 - cos θ). 
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A circle of 50 mm diameter rolls along a straight line without slipping. Draw the curve traced out by a 

point P on the circumference, for one complete revolution of the circle. Name the curve. Draw a 

normal and tangent to the curve at a distance 40 mm from Directrix line. 

Solution: 

1. With Circle Command C Draw a generating Circle center O with radius 25mm, using 

circle Command C. 

2. Assuming point P to be the initial position of the generating Point, draw a Horizontal line PA, by 

using Line Command L, mark the dimension as L = Πd using command DIMLIN. 
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3. Divide Circle into 12 equal parts by using DIV Command 

4. Give Numbering to All divisions of circle in anti-clock wise direction like 1,2,3..11 by 

using Text Command MTEXT. 
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5. Divide Directrix Line PA in to 12 equal parts by using DIV command and Give numbering 1’, 

2’. . 11’ by using MTEXT command. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Draw the line OB, parallel and equal to PA using offset command O. OB is the locus of the 

centre of the generating Circle. 
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7. Draw Horizontal lines from all divisions of Circle Parallel to PA by using Line Command L 

 
 
 
 
 
 
 
 
 

 
8. Draw vertical lines at 1’, 2’, 3’, etc., meeting OB at C1, C2…..C12 using Line command L. 

Mark as C1, C2 ….. using MTEXT command. 
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9. Draw a circle with C1 as centre and 25 mm radius using circle command C, create a point P1 

at the intersection of circle and 1 st horizontal line using POINT command PO 

 
 
 
 
 
 
 
 

 
10. Draw a circle with C2 as centre and 25 mm radius, using circle command C create a point 

P2 at the intersection of circle and 2nd horizontal line using POINT command PO. 
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11. Repeat the above procedure and mark remaining points P3 to P12. 
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12. With The help of SPLINE Command SPL Join all the points P1 to P12 for the generating 

cycloid. 
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To draw a normal and tangent to a cycloid. 

13. Mark a point M on the cycloid curve at 40 mm distance from the directing line by Using 

OFFSET command O. 
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14. With M as a centre and the radius 25 R, Draw Circle, which will cut the centre line OB at point 

R using Circle command C. After locating Point R remove Circle by using Trim Command TR. 
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15. Through point R, draw a line perpendicular to PA, Which meets PA at Point N using Line 

command L. 

16. Join NM and extend it to N’. The line NN’ is the required normal line. 
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17. Through Point M, draw a line TT’ Perpendicular to NN’. The line TT’ is the required tangent line. 

18. Make lines TTɪ and NNɪ perpendicular, select parametric from MENU BAR - geometric 

constraints - perpendicular - Select two lines. 
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EPICYCLOID: 

CYCLOIDAL CURVES 

• In geometry, an epicycloid or hypercycloid is a plane curve produced by tracing the path 

of a chosen point on the circumference of a circle—called an epicycle—which rolls 

without slipping around a fixed circle. It is a particular kind of roulette. 
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A circle of 50 mm diameter rolls on another circle of 150 mm diameter without slipping. 

Draw the curve traced out by a point P on the circumference, for one complete revolution 

of the circle. Name the curve. Draw a tangent to the curve at a point M 120mm radius 

from the center of the directrix. 

Solution: 

 

 
1. R = 75,, and r = 25mm 

2. Angle Ɵ= r/R * 360 = 120° 

3. Draw two lines at an angle of 60° from vertical line. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DEPARTMENT OF MECHANICAL 
ENGINEERING 



 
 
 

 

4. Draw a Directrix circle with 75mm radius with O as centre using Circle command C. Trim 

the circle outside the lines using Trim command TR. 

 

 

 

 

 

 

 

 
5. Draw a generating circle with 25mm radius above the directrix circle. The end of the 

generating circle should touch the end point of directrix arc as shown in the below figure. 
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6. Divide the generating circle in to equal parts using division command DIV. Mark the points 

as 1, 2, 3 etc. using Text command MTEXT. 

 

 

 

 

 

 

 

 
7. Draw circles with centre O, passing through centre and outer point of generating circle using 

Circle command C. 
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8. Divide the directrix arc in to equal parts using Division command DIV. Draw lines from O 

to the points using Line Command L. 

 

 

 

 

 

 

 

 
9. Extend the center lines to center arc using Extend command EX. Mark the points as 1’, 

2’,…12’ at the intersection of directrix arc and lines using Text command MTEXT. 
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10. Mark the points as C, C1, C2, ….C12 at the center arc using Text command MTEXT. 

 

 

 

 

 

 

 

 
11. Draw circles passing through all divided points of generating circle with centre O using 

Circle command C. Remove extra portion using Trim command TR. 
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12. With centres C, C1, C2, ….C12 and radius 25mm draw circles using Circle command C. 
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13. Create points at the intersection of circles and the arcs. Mark points as P1, P2, P3….P12 

using Text command MTEXT. Trim the circles using Trim command TR. 
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14. Create a curve by joining points P1, P2, P3….P12 using Spline command SPL to create 

Epicycloid. 
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To draw Tangent and Normal Lines 

15. Draw a circle with center O and radius 120mm using Circle command C. Create a point at 

the intersection of Epicycloid and circle using command PO. Mark point as M using Text 

command MTEXT. Remove some portion of circle using Trim command TR. 
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16. Draw a circle with center M and generating circle radius 25mm using Circle command C. 
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17. Draw a line joining O and M using line command L. Create a point at the intersection of 

line OM and directrix arc using Point command PO. Mark point as N using Text command 

MTEXT. 
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18. Draw a line joining M and N to create normal line using line command L. Extend the line 

using Extend command EX. Mark point N’. NN’ is the normal line. 
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19. Draw a line TT’ passing through M and normal to NN’ using Line command L. Extend the 

line using Extend command EX. Make lines TTᶦ and NNᶦ perpendicular, select 

parametric from MENU BAR - geometric constraints - perpendicular - Select two lines. 
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HYPOCYCLOID: 

CYCLOIDAL CURVES 

• In geometry, a hypocycloid is a special plane curve generated by the trace of a fixed 

point on a small circle that rolls within a larger circle. As the radius of the larger circle is 

increased, the hypocycloid becomes more like the cycloid created by rolling a circle on a 

line. 
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A circle of 50 mm diameter rolls inside of another circle of 150 mm diameter without 

slipping. Draw the curve traced out by a point P on the circumference, for one complete 

revolution of the circle. Name the curve. Draw a tangent to the curve at a point P on it. 

Solution: 

 

 
1. R = 75,, and r = 25mm 

2. Angle Ɵ= r/R * 360 = 120° 

3. Draw two lines at an angle of 60° from vertical line. 
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4. Draw a Directrix circle with 75mm radius with O as centre using Circle command C. Trim 

the circle outside the lines using Trim command TR. 

5. Draw a generating circle with 25mm radius below the directrix circle. The end of the 

generating circle should touch the end point of directrix arc as shown in the below figure 
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6. Draw circles with centre O, passing through centre and inner point of generating circle using 

Circle command C. . Trim the circle outside the lines using Trim command TR. 

 

 

 

 

 

 

7. Divide the generating circle in to equal parts using division command DIV. Mark the points 

as 1, 2, 3 etc. using Text command MTEXT. 
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8. Divide the directrix arc in to equal parts using Division command DIV. Mark the points as P, 

P1, P2…. using Text command MTEXT. 

 

 

 

 

 

 

 

 
9. Draw lines from O to the points using Line Command L. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
DEPARTMENT OF MECHANICAL 

ENGINEERING 



 
 
 

 

10. Draw circles passing through all divided points of generating circle with centre O using 

Circle command C. Remove extra portion using Trim command TR. 

 

 

 

 

 

 

 

 
11. Mark the intersection points of lines and center arc as C, C1, C2…. C12 using Text 

command MTEXT. 
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12. With centres C, C1, C2, ….C12 and radius 25mm draw circles using Circle command C. 

13. Create points at the intersection of circles and the arcs. Mark points as P1, P2, P3….P12 

using Text command MTEXT. Trim the circles using Trim command TR. 
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14. Create a curve by joining points P1, P2, P3….P12 using Spline command SPL to create 

Hypocycloid. 
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To draw Tangent and Normal Lines 

15. Draw a circle with center O and radius 60mm using Circle command C. Create a point at 
the intersection of Hypocycloid and circle using command PO. Mark point as M using Text 
command MTEXT. Remove some portion of circle using Trim command TR. 

16. Draw a circle with center M and generating circle radius 25mm using Circle command C. 

17. Draw a line joining O and M using line command L. Create a point at the intersection of 
line OM and directrix arc using Point command PO. Mark point as N using Text command 
MTEXT. 

18. Draw a line joining M and N to create normal line using line command L. Extend the line 
using Extend command EX. Mark point N’. NN’ is the normal line. 

19. Draw a line TT’ passing through M and normal to NN’ using Line command L. Extend the 
line using Extend command EX. Make lines TTᶦ and NNᶦ perpendicular, select 
parametric from MENU BAR - geometric constraints - perpendicular - Select two lines. 
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Involutes 



INVOLUTE 
 
 

 

INVOLUTE Definition : Involute is a path traced a point at the end of the string when it is wound or 

unwound from a cylindrical drum, cuboid or any tubular object. 

SOLVED EXAMPLES 1. Draw an involute of a circle of 50mm diameter. Also, draw a tangent and 

normal at any point on the curve. 

Procedure :  

1. Draw a circle of diameter 50 mm. 

2. Divide the circle into 12 equal parts and mark the names 1,2,3, etc., in clockwise direction 

starting from a point next to the bottom most one. Mark the centre point of the circle as O. 

3. Draw a tangent AC from point 12 for a length of L = πd, (d – diameter of circle). 



4. Divide AC into 12 equal points and the name points 1’,2’,3’..etc., 

5. Draw tangents from 1, 2, 3, etc., as shown in figure. 

6. With A-1’ as radius 1 as centre cut an arc on the tangent drawn from 1 and 

name the point as P1. 

7. Similarly obtain other points P10, P11, ..etc., 

8. Join all the points by a smooth curve to obtain an involute. 

Procedure to draw a tangent and normal to an involute : 

1. Mark a point N on the involute. 

2. Join N and O. With the midpoint of ON as centre, half of ON as the radius, drawa 

semicircle on the opening side of the involute. 

3. Mark the cutting point of the semicircle and circle as M. 

4. Join M and N, which will be the normal. 

5. Keep the protractor parallel to MN and draw a perpendicular from N, to draw the 

tangent. 



AutoCAD Procedure for Involutes of a Circle 

Step 1 
Draw the Circle: 
Command: CIRCLE:Specify the center point (e.g., 0,0),Type 25 for the radius (since the diameter is 50 mm).Press Enter. 
 

Step 2: Divide the Circle 
Divide the Circle into 12 Equal Parts: Command: DIVIDE ,Select the circle, Type 12 and press Enter. This creates division 

points on the circle, Mark the Division Points, Use the POINT command to place points at each division. Optionally, 
use the TEXT command to label these points as 1, 2, 3, etc., clockwise from the bottom-most point. 

 

Step 3: Draw the Tangent AC 
Draw the Tangent Line AC,Use the LINE command,Start from point 12. 
Specify a length of L=π×50≈157.08L = \pi \times 50 \approx 157.08L=π×50≈157.08 mm. You can type @157.08,0 

after 
clicking point 12,Mark the endpoints as A (at point 12) and C. 
 

Step 4: Divide the Tangent Line 
Divide the Tangent AC into 12 Equal Parts, Again, use the DIVIDE command., Select the line AC.Type 12 and press Enter, 

Label the Points on AC,Use the POINT command to mark points on AC as 1’, 2’, 3’, etc. 
 

Step 5: Draw Tangents from Circle Points 
Draw Tangents from Circle Points, For each point 1, 2, 3, ..., use the LINE command to draw tangents, Determine the 

angle to draw each tangent line from the respective circle points. 
Ensure these lines are tangent to the circle. 
 

Step 6: Construct Involute Points 
Create Involute Points,For Point P1,Set your compass radius to the distance between point A and 1’. 
Use the ARC command to draw an arc from point 1 towards the tangent line and mark the intersection 

as P1. Repeat this for points P2, P3, etc., down to P12. 
 
Step 7: Join Involute Points 



Join the Involute Points:Use the SPLINE or LINE command to connect points P1, P2, ..., P12 smoothly. 



Procedure for Drawing Tangent and Normal to the Involute 
Step 1: Mark a Point N on the Involute,Select a Point N:,Choose any point on the involute (e.g., P5). 
Step 2: Draw the Line ON ,Join N and O, Use the LINE command to connect point N to the center O. 
Step 3: Draw a Semicircle, Draw the Semicircle, Find the midpoint of line ON:Use the MIDPOINT command. 
With the midpoint as the center and half the distance of ON as the radius, draw a semicircle using the ARC 
command. Ensure the semicircle opens in the direction of the involute. 
Step 4: Mark the Cutting Point 
Find Intersection Point M,Use the INTERSECT command (or manual estimation) to find the point M where 
the semicircle intersects the original circle. 
Step 5: Draw the Normal 
Join M and N:,Use the LINE command to connect points M and N. This line MN is the normal. 
Step 6: Draw the Tangent 
Draw the Tangent:,Use a protractor or the ANGLE command:,lign it parallel to line MN,Draw a perpendicular 
line from point N to represent the tangent. 
Final Steps 
Label Points and Lines: 
Use the TEXT command to label points N, M, and the tangent and normal lines. 
Save Your Work: 
Use SAVEAS to save your drawing in your desired format 



 
 
 
 

Vertical Plane and Front Elevation A view looking from the front is projected onto the vertical plane. This view is 

called front view or front elevation and shows the width and height dimensions. A vertical plane of projection, 

which is behind the object in relation to the observer, is shown in figure below. 

Horizontal Plane and Top View A view looking from the top is projected onto the horizontal plane placed below 

the object. This view is called top view or plan. Top view shows the width and depth dimensions of an object. A 

horizontal plane with a top view is shown in figure below.  
 

 
 
 

Profile Plane and End View 
 

A view looking from the side of an object is projected onto the profile plane. The observer and 



the projection plane are on different sides of the object (i.e.) the object is between the observer 

and the projection plane. The viewing can be from the right or the left side of the object. The 

view drawn looking the object from the right is called right side view or right end elevation. The 

view looking the object from the left is called left side view or left end elevation. Side view of 

an object shows the depth and height dimensions. A profile plane with a left side view is shown 

in figure below. 

 

 
 

 
First Angle Projection 

 

An arrangement of vertical, horizontal, and profile planes and quadrants used to draw first angle 

projections is shown below. Front view is projected onto the vertical plane, top view onto the 

horizontal plane, and side view onto the profile plane.  



 

 
 
 
 

Projection in First Angle 
 

An object placed in the first quadrant. The vertical plane is behind the object, horizontal plane 

below the object, and profile plane to right of the object. The views with the corresponding planes 

are shown in figure. The top view is seen below the elevation and left side view is seen on the 

right of front view. This is the arrangement of views in the first angle projection. 

 
 

 
Projection in Third Angle: 

 

An object placed in the third quadrant. The vertical plane is in front of the object, horizontal plane 

above the object and profile plane to the left of the object. The views with corresponding planes 



are shown in figure. Top view is above the front view and left side view is to the left of the front 
 

view. This is the arrangement of the views in third angle projection.  
 

 
 

 
Multiview Projection 

 

It consists of a set of two or more orthographic views of an object taken from different directions, 

which are mutually perpendicular. These views are arranged relative to each other in a particular 

way. Each of these views shows the shape of the object for a particular view direction. Multiple 

views collectively describe the object completely and exactly. Hence, multiview projections are 

used in engineering to describe the true shape of any object. 

 



Projections of Points 

Point A point usually represented by a dot is a dimensionless geometrical entity that has a position but no 

magnitude. Whereas in computer aided engineering drawing the point has dimension but it is not considered or 

neglected. A point is obtained wherever two straight or curved lines intersect each other. 

Projection of Points Projection of points in various quadrants is the basis for projection of lines, projection of 

planes 

 
 

 
 
 

In projections, two principal planes are used to get the projection of an object that is vertical plane and horizontal 

plane, the vertical plane denoted by (V.P.) and horizontal plane denoted by (H.P.) as shown in Fig. They intersect 

each other at right angles and the line of intersection is known as axis of the plane. The vertical plane of 

projection is always infront of the observer and the projection on this plane is known as front view or elevation. 

The other plane is the horizontal plane of projection and the projection on this plane is called the top view or plan. 

Pictorial view of Principal Planes 

 

The view obtained by viewing object form right side is called right side view or right end view. A plane 

perpendicular to both H.P. and V.P. is called profile plane (P.P). The right side view is always on the right to the 

front view. If the object is viewed from left on profile plane then the view is known as left side view or left end 

view.  

Position of Points in Various Quadrants 



1. When point is in First Quadrant When a Point P is situated in I quadrant i.e., above H.P. and in front of V.P. , Its 

front view (p’) will be above XY line and its top view (p) will be below the XY line. 

 
 

 

 

 
 
 

2. When point is in Second Quadrant When a Point P is situated in II quadrant i.e., above H.P. and behind V.P. , 

Its front view (p’) will be above XY line and its top view (p) will also be above the XY line. 



 

 
 

 

 
 

 

3. When point is in Third Quadrant When a Point P is situated in III quadrant i.e., below H.P. and behind of V.P. , 

Its front view (p’) will be below XY line and its top view (p) will be above the XY line 

4. When point is in Fourth Quadrant When a Point P is situated in IV quadrant i.e., below H.P. and infornt V.P. , Its 

front view (p’) will be below XY line and also its top view (p). 



 

 
 
 



 

 
 
 

 
 
 

Positions of geometrical entities in various quadrants of the projections 

 

When 

Position 

Quadrant Front View Top View 

VP HP 

Point is Infront Above I Above XY Below XY 

Point is Behind Above II Above XY Above XY 

Point is Behind Below III Below XY Above XY 

Point is Infront Below IV Below XY Below XY 



Point is Infront In or on I or IV On XY Below XY 

Point is In or on Above I or II Above XY On XY 

Point is Behind In or on II or III On XY Above XY 

Point is In or on Below III or IV Below XY On XY 

Point is In or on In or on I, II, III, or IV On XY On XY 

System of Notation 1. The actual points in space are denoted by capital letters A, B, C etc. 
 

2. The front view (FV) of the points are denoted by their corresponding lower-case letters with 

dashes as a', b', c', etc. 

3. The top view (TV) of the points are denoted by their corresponding lower-case letters without 

dashes as a, b, c etc. 

4. The side view (SV) of the points are denoted by their corresponding lower-case letters with 

double dashes as a", b", c" etc. 

5. Projectors are always drawn as continuous thin lines and Points with Dot. 
 

In Computer Aided Engineering Graphics for projection of points following commands are used other than 

evoking software, opening file, saving file and giving print command. Using these minimum nine commands any 

type of projection of point problem can be solved they are as follows: 1. Select tool Command. 2. Point 

command. 3. Poly-line command. 4. Two point line command. 5. Parallel line command. 6. Bisector command. 7. 

Smart dimension command. 8. Line width command. 9. Insert text command.  

Solved Problem: 1.Draw the projections of the following points on the same ground line, keeping the projectors 

25 mm apart. 

i. A is in the H.P. and 20 mm behind the V.P. 
 

ii. B is 40 mm above the H.P. and 25 mm in front of the V.P. 
 

iii. C is in the V.P. and 40 mm above the H.P. 
 

iv. D is 25 mm below the H.P. and 25 mm behind the V.P. 
 

v. E is 15 mm above the H.P. and 50 mm behind the V.P. 
 

vi. F is 40 mm below the H.P. and 25 mm in front of the V.P. 
 

vii. G is in both the H.P. and the V.P. 



 

 
 
 

 

Solution 1. Open the Software. Click on the Application Menu and click on New and select “acad “in 
 

the open dialog box and click Open. 2. Enter the command “UNITS “in command bar and Select units as 

“Millimeters and click 

ok. 3. Enter the command “LIMITS “in command bar and enter 0,0 click enter and enter upper 
 

right corner as 120,90 and click enter 4. Enter the command “ZOOM “in command bar and enter A and click enter 

5. As per the problem ,draw a XY line by using Xline command. Mark VP and HP above and 
 

below it by using “XTEXT” command in command bar 6. Divide the line into some equal parts depend upon how 

many points given. 7. Draw the lines representing the Projectors as per the dimensions mentioned in the problem 

and mark the front and top views of the points using Point command. 8. Mention the dimensions for all points 

from the XY line using dimlinear command  

Practice Problems 1. Draw the orthographic projections of the following points. 
 

i. Point P is30 mm. above H.Pand40mm.infrontof VP. 
 

ii. Point Q is25 mm. Above H.P and 35mm.behind VP. 
 

iii. Point R is 32 mm. below H.P and 45mm behind VP. 
 

iv. Point S is 35 mm. below H.P and 42mm in front to VP. 
 

v. Point T is in H.P and 30 mm behind VP. 
 

vi. Point U is in V.P and 40 mm. below HP. 
 

vii. Point V is in V.P and 35 mm. above H.P. 
 

viii. Point W is in H.P and 48 mm. in front of VP. 
 

2. Draw the projections of the following points on the same XY line, keeping convenient distance 

between each projectors. Name the quadrants in which they lie. 



i. Point A is 30 mm above HP and 35 mm in front of VP. 
 

ii. Point B is 35 mm above HP and 40 mm behind VP. 
 

iii. Point C is 40 mm above HP and on VP. 
 

iv. Point D is 35 mm below HP and 30 mm in front of VP. 
 

3. Draw the projections of the following points on the same XY line, keeping convenient distance 

between each projectors. Name the Quadrants in which they lie. 

i. Point E is 30 mm below HP and 25 mm behind VP. 
 

ii. Point F is 35 mm below HP and 30 mm in front of VP. 
 

iii. Point G is on HP and 30 mm in front of VP. 
 

iv. Point H is on HP and 35 mm behind VP.  
 

Projection of Straight Lines 

Introduction A line may be defined as the locus of a point moving along a fixed path. A line consists of a number 

of points; its projections are drawn by joining the projection of its extreme (end) points. Hence, the projections of 

a straight line may be drawn by joining the respective projections of its ends, which are points. In a conventional 

drawing, a line has only length but no thickness . Whereas in computer aided engineering graphics the line has 

length and thickness. 

The position of a straight line may have different orientations in space. As per first angle projection, it may be 

parallel, perpendicular or inclined to either or both the Reference planes (horizontal or vertical planes) as 

mentioned in the below classification. 

Classification of Line Positions A line may be placed in infinite number of positions with respect to the 

reference planes. These positions may be classified according to the inclination of the line to reference planes 

and the quadrants in which it is placed. 

1. Line parallel to both the reference planes (HP & VP) 
 

(a) Line away from both HP and VP. 
 

(b) Line in HP and away from VP. 
 

(c) Line in VP and above HP. 
 

(d) Line on both HP and VP. 
 

2. Line perpendicular to either of reference planes (HP or VP) 
 

(a) Line perpendicular to HP and away from VP. 
 

(b) Line perpendicular to HP and on VP. 
 

(c) Line perpendicular to VP and above HP. 
 

(d) Line perpendicular to VP and on HP. 
 

3. Line inclined to HP and parallel to VP 
 

(a) Line inclined to HP, parallel to VP and away from VP. 
 

(b) Line inclined to HP, parallel to VP and in VP. 
 

4. Line inclined to VP and parallel to HP 
 

(a) Line inclined to VP, parallel to HP and away from HP. 
 

(b) Line inclined to VP, parallel to HP and in HP. 



5. Line inclined to both HP and VP 
 

(a) One end of line in HP and the other end away from VP. 
 

(b) One end of line in VP and the other end away from HP.  
(c) One end above HP and the other end away from VP. 

 

(d) One end away from VP and the other end above HP. 
 

(e) One end in HP and VP and other end away from HP and VP. 
 

(f) Both ends on HP and VP. 

 

 

 
 
 

System of Notation 1. The actual line in space is denoted by capital letters A and B, or C and D etc. 
 

2. The front view (FV) of a line is denoted by their corresponding lower letters with dashes as a' 

and b', c' and d' etc. 

3. The top view (TV) of a line is denoted by their corresponding lower case letters without dashes 

as a and b, c and d etc. 

4. The side view (SV) of a line are denoted by their corresponding lower case letters with double 

dashes as a" and b", c" and d" etc. 

5. Projectors are always drawn as continuous thin lines. 
 

6. Line with specific thickness for a particular type of line. 
 

Solved Problems 1.Draw the projections of a 75 mm long straight line, in the following positions: 
 

i. Parallel to both the H.P. and the V.P. and 25 mm from each. 



ii. Perpendicular to the H.P., 20 mm in front of the V.P. and its one end 15 mm above the 

H.P. 

iii. Inclined at 30° to the H.P. and its one end 20 mm above it; parallel to and 30 mm in front 

of the V.P. 

i. Parallel to both the H.P. and the V.P. and 25 mm from each. Solution: 1. Draw XY line Using Xline Command. 

 

2. Mark the annotations X, Y, VP, HP to the line drawn by using INSERT TEXT 

command from drafting tool bar. This must be done just by typing and inserting at the 

required positions using the left click of the mouse. 

3. According to question 75 mm line Parallel and 25 mm from HP put the Point 25 mm 

from above XY line by Using Point Command Name the Point with p’ 

4. As per the problem, mark points p, q, p’ and q’ according to the dimensions given on 

boths side of XY line. 

5. Draw a line of 75 mm that is parallel and above XY from point p’ to q’ by using Text 

command. 

6. Draw another line of 75 mm parallel line and below XY from point p to q by using 



 

 
 
 

 
Text command 

 

7. Mention the Dimensions by using DIMLINEARCommand. 
 

ii. Perpendicular to the H.P., 20 mm in front of the V.P. and its one end 15 mm above the H.P. 

Solution: 1. Draw XY line By Using Line Command L and Name with X,Y at two ends By Using 

Text Command 

2. According to question 75 mm line perpendicular to HP and 15 mm above HP. put the 

Point 15 mm from above XY line by Using Point Command Name the Point with p’ 

3. Line Parallel to and 25 mm in front of VP Put the point 25 mm below the XY line by 

using Point Command. Name the Point with p. 

4. Draw 75 mm perpendicular line from p’. Name the end point q’ by using Text command 
 

5. When line Perpendicular to HP & Parallel to VP in top view Line Like Point its two 

end points on the same point then mention q on the same point 25 below XY line 

6. Mention the Dimensions by using DIMSTYLECommand. 



iii. Inclined at 30° to the H.P. and its one end 20 mm above it; parallel to and 30 mm in front 

of the V.P. 

Solution: 1. Draw XY line By Using Line Command L and Name with X,Y at two ends By Using 

Text Command 

2. According to question 75 mm line30 inclined and 20 mm above the H.P put the Point 

20 mm from above XY line by Using Point Command Name the Point with p’ 

3. Line Parallel to and 30 mm in front of VP Put the point 30 mm below the XY line by 

using Point Command. Name the Point with p. 

4. Draw 75 mm linen from p’ with inclination of 30. Name the end point q’ by using Text 

command Name it F.V 

5. When line Inclined to HP & Parallel to VP in top view Line will be reduced Draw 

Perpendicular line from q’ to locus of p name the intersection point as q & Name the 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

reduced line as Length of Top View (LTV). 



6. Mention the Dimensions by using DIMLINEARCommand 

2.A line AB 80 mm long has its end A 20 mm above the HP and 30 mm 

in front of VP. It is inclined at 30° to HP and 45° to VP. Draw the 

projections of the line. 

Solution: 
 

1. Draw XY line By Using Line Command L and Name with X,Y at two ends By Using Text 

Command 

2. According to question 80 mm line 30θ inclined and 20 mm above the H.P put the Point 20 

mm from above XY line by Using Point Command Name the Point with p’ 

3. Draw 80 mm line from p’ with inclination of 30 θ. Name the end point q1’ by using Text 

command 

4. According to question 80 mm line 45θ inclined and 30 mm in front of V.P put the Point 30 

mm from above XY line by Using Point Command Name the Point with p 

 

 
 
 

command 
 

6. Draw perpendicular line from q1’ to locus of p name it As q1. Draw another Perpendicular line 

from q2 to locus od p1 name the intersection point as q2’ 



7. Name p’q2’ Line as LFV and Name pq1 line as LTV. 
 

8. For Final front View take P’ as center p’q2’line as radius draw arc which will intersect Locus 

of P’ at q’ Join p’q’ LINE it as FFV 

9. For Final Top View take P as center p’q1’ line as radius draw arc which will intersect Locus 

of P at q Join p q line it as FTV 

10. Mention the Dimensions by using DIMLINEARCommand.  

11. Practice Problems: 
 

1. The top view of a line AB, 80 mm long measures 65 mm and the length of the front view is 50 

mm. The end A is on HP and 15 mm infront of VP. Draw the projections 

2. Line AB has its end A 20 mm above the HP and 15 mm infront of the VP. The other end B is 

60 mm above the HP and 45 mm in front of VP. The distance between end projectors is 70 

mm. Draw its projections. Determine the apparent lengths and true inclinations. 

3. A line has its end A 10 mm above HP and 15 mm in front of VP. The end B is 55 mm above 

HP and line is inclined at 30º to HP and 35º to VP. The distance between the end projectors is 

50 mm. Draw the projections of the line. Determine the true length of the line and its inclination 

with VP. 

4. A line CD 60mm long has its end ‘C’ in both H.P. and V.P. It is inclined at 300to H.P. and 450 

to V.P. Draw the projections. 

5. A point C is 40mm below H.P. and 20mm behind V.P. another points D and E are 60mm above 
 

H.P. and in front V.P., 90mm below H.P. and 45mm in front of V.P. respectively. Draw the 

projections of all points on same reference line. 

6. The end P of a straight line PQ is 20 mm above the H.P. and 30mm in from V.P. The end Q is 

15mm below the H.P. and 45mm behind the V.P. If the end Projectors are 50mm apart, Draw 

the Projection of PQ and determine the true length, traces and inclination with the reference 

planes. 

7. The front view of line inclined at 300 to V.P. is 65mm long. Draw the projections of a line, 

when it is parallel to and 40mm above H.P. and one end being 20mm in front of V.P. 

8. Line PQ has72mm length in the front view and 66mm length in the top view. The end P is 

48mm below HP and 40mm behind VP, while the end Q is 12mm below HP. Draw the 

projection of the line, locate the traces and determine the true length and inclinations of the 

line with the reference planes.  



 
 

PROJECTIONS OF PLANES & 

SOLIDS 

 

 
 

Projection of Planes 

Introduction 
 

A plane is a two-dimensional geometrical entity. It has length and width but no thickness. For 

 
 
 



 

extent is termed as a lamina. 

A plane can be located by: 

(i) Three non-collinear points, 
 

(ii) A straight line and a point outside it, 
 

(iii) Two parallel or intersecting straight lines, or 
 

(iv) Traces of the lines. 
 

This chapter deals with the projections of laminas of pre-defined shapes, e.g., triangular plane, 

square plane, rectangular plane, pentagonal plane, hexagonal plane, circular plane, semicircular 

plane, etc. Sometimes, a given plane is composed of two or more planes mentioned above. Such 

planes are called composite planes, e.g., plane composed of a half hexagon and a semicircle, 

circular plane with hexagonal hole, etc. 

Planes 

 

Positions of Planes 

1. Plane parallel and perpendicular to reference planes (HP & VP) 
 

A. Plane parallel to HP and perpendicular to VP. 
 

B. Plane parallel to VP and perpendicular to HP. 
 

2. Plane perpendicular and inclined to reference planes (HP & VP) 
 

A. Plane perpendicular to HP and inclined to VP. 
 

B. Plane perpendicular to VP and inclined to HP. 
 

3. Plane perpendicular to both HP & VP. 
 

4. Plane inclined to both HP & VP 
 

A. Inclination to HP and VP is not equal to 90°. 
 

B. Inclination to HP and VP is equal to 90°. 
 

Terms Used in Projections of Planes 
 

The following terms must be understood before we proceed for the step-by-step procedure of 

obtaining the projections of a plane. 

True Shape: The actual shape of a plane is called its true shape. 
 

Inclination with the RPs: The inclination of a plane with an RP is the acute angle the plane makes 

with that RP. It is always measured in a plane perpendicular to the given plane and the RP. 

Inclination with the HP (θp) It is the acute angle the plane makes with the HP. 
 

Inclination with the VP (ϕp) It is the acute angle the plane makes with the VP. 
 

Traces of the Plane: Just like a line, a plane also has traces. The traces of a plane are the lines of 

intersections of the plane with the RPs. A plane may have a horizontal trace or vertical trace or 



both. 
 

Horizontal Trace (HT) The real or imaginary line of intersection of a plane with the HP is 

called horizontal trace of the plane. HT is always located in the TV. 

Vertical Trace (VT) The real or imaginary line of intersection of a plane with the VP is 

called vertical trace of the plane. VT is always located in the FV. 

It should be noted that the plane has no trace on the RP to which it is parallel. For example, a plane 

parallel to the HP will have no HT. Similarly, a plane parallel to the VP will have no VT. HT and 

VT of a plane (produced if necessary) meet at a point on the XY.  

Perpendicular Planes: The planes perpendicular to one or both the RPs are called perpendicular 

planes. The first three positions of the planes mentioned in the previous section represent 

perpendicular planes. 

Oblique Planes: The planes inclined to both the RPs are called oblique planes. The fourth position 

of the planes mentioned in the previous section represents oblique planes. 

Line View or Edge View: The view of a plane seen as a line is called line view or edge view of the 

plane. One view of a perpendicular plane is always an edge view. The edge view always represents 

the trace of the plane. For example, if a plane is perpendicular to the VP, then its FV will be an 

edge view representing VT of the plane. Similarly, TV of a plane perpendicular to the HP Will be 

an edge view representing HT. 
 

System of Notation 
 

1. The actual plane in space is denoted by capital letters A, B, C and D etc. 
 

2. The front view (FV) of a plane is denoted by their corresponding lower-case letters with 

dashes as a', b', c' and d' etc. 

3. The top view (TV) of a plane is denoted by their corresponding lower-case letters without 

dashes as a, b, c and d etc. 

4. The side view (SV) of a plane are denoted by their corresponding lower-case letters with 

double dashes as a”, b", c" and d" etc. 

5. Projectors are always drawn as continuous thin lines. 
 

6. Line with specific thickness for a particular type of line. 
 

In Computer Aided Engineering Graphics for projection of plane following commands are used 

other than evoking software, opening file, saving file and giving print command. Using these 

minimum12 commands any type of projection of line problem can be solved they are as follows: 

1. Select tool Command. 
 

2. Point command. 
 

3. Poly-Line command. 



4. Two Point Line command. 
 

5. Parallel line command. 
 

6. Center Circle command 
 

7. Bisector command. Computer Aided Engineering Graphics (CAEG) B.TECH – I YEAR 
 

8. Smart Dimension command. 
 

9. Line Width command. 
 

10. Insert Text command. 
 

11. Move Copy command. 
 

12. Rectangle command. 
 

Plane parallel and perpendicular to reference planes (HP & VP) 
 

If the given plane is parallel to an RP, it remains perpendicular to the other RP. In such a case, the 

view of the plane on the RP to which it is parallel gives the true shape. Another view is always an 

edge view parallel to XY. 

Plane parallel to HP and perpendicular to VP. 
 

 
 

 
FV will be an edge view parallel to XY. SV will be perpendicular to XY. 

 
Plane parallel to HP and perpendicular to VP. 

 

Plane parallel to VP and perpendicular to HP. If a plane is parallel to the VP, its FV gives the true shape. 

Therefore, FV should be drawn first. 

TV will be an edge view parallel to XY. SV will be perpendicular to XY. Computer Aided Engineering Graphics 

(CAEG) B.TECH – I YEAR 

Plane parallel to VP and perpendicular to HP. 

 

Plane Inclined to one RP and Perpendicular to the other RP 
 

If a plane is inclined to one RP and perpendicular to the other RP, none of its views will give the 

true shape. The view on the RP to which the plane is inclined will be smaller than the actual size 

of the plane. The view on the RP to which the plane is perpendicular will be a line view. Such 



problems can be solved in two stages. In the first stage, the given plane is assumed to be parallel 

to the RP to which it is finally inclined. The true shape can thus be obtained in one view. In the 

second stage, another view (which is an edge view parallel to XY) is tilted so as to make desired 

inclination with the first RP. 

Plane Inclined to the HP and Perpendicular to the VP When the surface of the plane is inclined at θ to the H.P. 

and perpendicular to the V.P., the 

projections are obtained in two stages. In the first stage, the plane is assumed to lie on the H.P. 

The true shape of the plane is viewed in the top view and a straight line lying on xy in the front 

view. In the second stage, the plane is tilted at θ to the H.P. The front view is redrawn inclined at 

θ to the xy. The final top view is obtained by joining the points of intersection of the vertical 

 
 
 

top view of the preceding stage. 
 

Note 1 If the plane has a side on the H.P. (or parallel to the H.P. or on the ground), then keep an 

edge of the plane perpendicular to xy in the top view of the first stage. 

Note 2If the plane has a corner in the H.P. (or on the ground), then keep the line joining a corner 
 

and the centre of the plane parallel to xy.  



 
 
 
 
 

Plane Inclined to the HP and Perpendicular to the VP 

 

Plane Inclined to the VP and Perpendicular to the HP When the surface of the plane is inclined at ϕ to the V.P. 

and perpendicular to the H.P., the 

projections are obtained in two stages. In the first stage, the plane is assumed to lie on the V.P. 

The true shape of the plane is viewed in the front view and a straight line lying on xy in the top 

view. In the second stage, the plane is tilted at ϕ to the V.P. The top view is redrawn inclined at ϕ 

to the xy. The final front view is obtained by joining the points of intersection of the vertical 

projectors of the corners from the top view with the horizontal projectors of the corners from the 

front view of the preceding stage. 

Note 1 If the plane has a side on the V.P. (or parallel to the V.P. or on the ground), then keep an 

edge of the plane perpendicular to xy in the front view of the first stage. 

Note 2If the plane has a corner in the V.P. (or on the ground), then keep the line joining a corner 

and the centre of the plane parallel to xy in the front view of the first stage. 

 
 
 
 

Plane Inclined to the VP and Perpendicular to the HP 



Plane perpendicular to both HP & VP. 

 
 

 
perpendicular to XY. Such a plane is parallel to the PP and hence its true shape is seen in SV. 

Therefore, for such problems, it is advisable to draw SV first. 

Plane Perpendicular to both HP & VP 

 

Plane inclined to both HP & VP. 
 

A plane inclined to both the RPs is called an oblique plane. None of the views of the oblique plane 

gives the true shape. It should be noted that the angles made by the oblique plane with the RPs 

(i.e., θ and ϕ) might not be directly given in the problem. Often, either of the inclinations, θ or ϕ, 

is given along with some other condition(s) that automatically pose the restriction on the other 

inclination. 

The problems on oblique planes are solved in three stages. In the first stage, the plane is often 

assumed to be parallel to one of the RPs so that the true shape can be obtained in one view. In the 

second stage, the given angle between the plane and the RP (i.e., either the HP or the VP) or some 

 



 

other condition mentioned in the problem is established. In the third stage, all other remaining 

conditions are satisfied. 

Plane Inclined to both HP & VP 

 
 

Solved Problems 1. An equilateral triangular lamina of 25 mm side lies with one of its edges on HP such that the 

surface of the lamina is inclined to HP at 60º. The edge on which it rests is inclined to VP at 

60º. Draw the projections. 
 

Solution 
 

1. Open the Software. Click on the Application Menu and click on New and select “acad “in the 

open dialog box and click Open. 

2. Enter the command “UNITS “in command bar and Select units as “Millimeters and click ok. 
 

3. Enter the command “LIMITS “in command bar and enter 0,0 click enter and enter upper right 

corner as 120,90 and click enter 

 

 
 
 

4. Enter the command “ZOOM “in command bar and enter A and click enter 
 

5. Draw a XY line by using line command. Mark VP and HP above and below it by using 

“XTEXT” command in command bar 

6. As per the problem equilateral triangular lamina of 25mm has to be drawn in HP, hence draw 

a vertical line of 25 mm using POLYLINE command and in format select VL and enter length 

as 25 and angle as –90 in mini dialog box. Mark annotations a and b using XTEXT Command 

as shown below. 



 

 
 
 
 

7. Draw an arc of radius of 25 from a and b to cut each other at c using CENTER CIRCLE 

command in drafting tool bar and in format select PL. In mode option select arc. Join abc to 

get triangular lamina of 25 mm using POLYLINE command 

8. Draw front view of the triangular lamina using POLYLINE command and in format select 

VL, mark annotations as (a') b' and c' as shown below. 

 

 
 

 
9. Since the lamina is inclined at 60° to HP. By using POLYLINE command and in format select 

VL enter length equal to length of first stage front view and angle as 60 in mini dialog box, 

mark annotations as (a') b' and c' using XTEXT Command 

10. Draw vertical projectors downwards from the second front view using POLYLINE command 

and in format select PL. Draw horizontal projectors from top view to intersect vertical 



projectors at a, b and c which forms the second stage top view as shown below. 

 

 

 
 

 
11. Since the edge on which it rests is inclined to VP to 60° Draw a line of 60° in HP using 

POLYLINE command and in format select PL. From edit menu select MOVE COPY 

command and then select second stage top view. In selection tree right click on the start point 

and click reset to select the start point anywhere on the edge of lamina to shift on to 60° line 

drawn. Click and drag the lamina on 60° line. Click or drag to rotate and enter angle as 30 in 

mini dialog box and click on OK 

12. Draw the vertical projection upwards from all the corners of triangular lamina from third stage 

top view using POLYLINE command and in format select PL. Again, draw horizontal 

projectors from second stage front view to intersect vertical projectors at a' b' and c'. 

 

 



 

13. Join a' b' and c' using POLYLINE Command 
 

14. Using DIMENSION Command in Annotation tool bar or Enter DIM command in command 

bar dimension the drawing  

 

 
 

 
2. A square plate of 40 mm side rests on HP such that one of the diagonals is inclined at 30º to 

HP and 45º to VP. Draw its projections. 

 

 
 
 

Solution 
 

1. Open the Software. Click on the Application Menu and click on New and select “acad “in the 



open dialog box and click Open. 
 

2. Enter the command “UNITS “in command bar and Select units as “Millimeters and click ok. 
 

3. Enter the command “LIMITS “in command bar and enter 0,0 click enter and enter upper right 

corner as 100,100 and click enter 

4. Enter the command “ZOOM “in command bar and enter A and click enter  

5. Draw a XY line by using line command. Mark VP and HP above and below it by using 

“XTEXT” command in command bar. 

6. As per the problem a square lamina of 40 mm has to be drawn in HP, hence draw a square of 

40 mm using RECTANGLE command Now enter X size = 40, Y size = 40 and angle as 45 in 

mini dialog box. Mark annotations a b c and d using XTEXT Command as shown below. 

 

 
 
 

7. Draw the vertical projection upwards from all the corners of square lamina in top view until it 

touches XY line, using POLYLINE command and in format select PL. 

8. Draw front view of the triangular lamina using POLYLINE command and in format select VL, 

mark annotations as a' b' c' and (d') as shown below. 

 



 

9. Since the diagonal of lamina is inclined at 30° to HP. By using POLYLINE command and in 

format select VL enter length equal to length of first stage front view and angle as 30 in mini 

dialog box, mark annotations as a' b' (d') and c' using XTEXT command 

10. Draw vertical projectors downwards from the second front view using POLYLINE command 

and in format select PL. Draw horizontal projectors from top view to intersect vertical 

projectors at a, b c and d which forms the second stage top view as shown below.  

 

 

 
 

 
11. Since the diagonal of lamina is inclined to VP at 45°. Draw a line of 45° in HP using 

POLYLINE command and in format select PL. Draw an arc of radius equal to diagonal length 

of lamina from first stage top view to cut on 45° line drawn. Draw a locus from point a1, now 

with radius equal to diagonal length of lamina from second stage top view to cut on the locus. 

Join ac to get the diagonal of third stage top view. From edit menu select MOVE command 

and then select second stage top view. In selection tree right click on the start point and click 

reset to select the start point anywhere on the diagonal of lamina to shift on to new diagonal 

line drawn. Click and drag the lamina on new diagonal line. Click or drag to rotate and enter 

angle so as to match both diagonals and click on OK. Mark annotations as a b c and d. 

12. Draw the vertical projection upwards from all the corners of square lamina from third stage 

top view using POLYLINE command and in format select PL. Again, draw horizontal 

projectors from second stage front view to intersect vertical projectors at a' b' c' and d'. 

13. Join a' b' c' and d' using LINE Command and in format select VL. 



 

 
 
 
 

14. Using DIMENSION Command in Annotation tool bar or Enter DIM command in command 

bar dimension the drawing 

Practice Problems 
 

1. A Square plane with a 40 mm side has its surface parallel to and 20mm above the HP. Draw 

its Projections, when 

A. A side is parallel to VP 
 

B. A side is inclined at 300to VP and 
 

C. All sides are equally inclined to VP. 
 

2. A Hexagonal plane with a 30mm side has its surface parallel to and 20mm infront of the VP. 

 
 



Draw its Projections, when 
 

A. A side is perpendicular to HP 
 

B. A side is parallel to the HP 
 

C. Side is inclined at 450 to the HP 
 

3. A Pentagonal plane with a 30 mm side has an edge on the HP, the surface of the Plane is 

inclined at 450 to the HP. Draw it’s Projections? 

4. A Hexagonal plate with a 30mm side and negligible thickness has its surface Perpendicular to 

the HP and inclined at 450 to the VP. Draw its Projections? When one of its sides of the Plane 

is Parallel to and 15 mm Infront of the VP  
 

5. A Circular plane with a 60 mm Diameter is resting on a point it’s circumference on the VP. 

The center is 40mm above the HP, and the surface is inclined at 450 to the VP. and 

perpendicular to the HP Draw Its Projections? 

6. Rectangle 30mm and 50mm sides is resting on HP on one of its small side which is 300 inclined 

to VP, while the surface of the plane makes 450 inclination with HP. Draw it’s projections? 

7. A regular pentagon of 30 mm sides is resting on HP, on one of its sides with its surface 450 

inclined to HP. Draw it’s projections when the side in HP makes300 angle with VP? 

8. A circle of 50mm diameter is resting on HP on end A of its diameter AC which is 300 inclined 

to HP while it’s TV is 450 inclined to VP. Draw its Projections? 

9. A semicircle of 100mm diameter is suspended from a point on its straight edge 30mm from 

the midpoint of that edge so that the surface makes an angle of 450 with VP. Draw its 

projections. 

10. A pentagon of sides 30mm rests on the ground on one of its corners with the sides containing 

the corners being equally inclined to the ground. The side opposite to the corner on which it 

rests is inclined at30degrees to the VP and is parallel to the HP. The surface of the pentagon 

makes10 degrees with the ground. Draw the top and front views of the pentagon. 

11. A regular pentagon of 30mm side is resting on one of its edges on HP which is inclined at 45 

degrees to VP. Its surface is inclined at 30degrees to HP. Draw its projections. 

12. Draw the projections of a regular hexagon of 25mm side, having one of its sides in the H.P. 

and inclined at 60degrees to the V.P and its surface making an angle of 45degreeswithH.P. 

13. A thin circular plate of 40mm diameter having its plane vertical and inclined at 40 to V.P. Its 

center is30mm above H.P. and 35mm infront of V.P. Draw the projections.  



 

Projections of Solids 

Introduction 
 

Any object having definite length, width and height is called a solid. In engineering drawing, solids 

are often represented by two or more orthographic views, i.e., FV, TV or SV. The study of the 

projections of a solid is very important in mechanical-design problems. The knowledge of 

projections of solids is essential in 3D modeling and animation. Projections of solids find wide 

applications in the construction industry. 

Basic Solids 
 

Basic solids are those which have predefined shapes. The basic solids are the constituent parts of 

any complex solid. Objects in the real world are made up of combinations of basic solids. In 3D 

modeling, the basic solids are called solid primitives. Solid primitives are combined in logical 

ways to obtain the desired 3D shape. 
 

System of Notation 
 

7. The actual plane in space is denoted by capital letters A, B, C and D etc. 
 

8. The front view (FV) of a plane is denoted by their corresponding lower-case letters with dashes 

as a', b', c' and d' etc. 

9. The top view (TV) of a plane is denoted by their corresponding lower-case letters without 

dashes as a, b, c and d etc. 

10. The side view (SV) of a plane are denoted by their corresponding lower-case letters with 

double dashes as a”, b", c" and d" etc. 

11. Projectors are always drawn as continuous thin lines. 
 

12. Line with specific thickness for a particular type of line. 
 

In Computer Aided Engineering Graphics for projection of solids following commands are used 

other than evoking software, opening file, saving file and giving print command. Using these 

minimum 13 commands any type of projection of line problem can be solved they are as follows: 1. Select tool 

Command. 

2. Point command. 
 

3. Poly-Line command. 
 

4. Two Point Line command. 
 

5. Parallel line command. 



6. Center Circle command 
 

7. Bisector command. 
 

8. Smart Dimension command. 

 
 

 
 
 

10. Insert Text command. 
 

11. Move Copy command. 
 

12. Rectangle command. 
 

13. Smart Delete Command 
 

Classification of solids 
 

Figure 3.1Classification of Regular Solids 

 

Polyhedron A polyhedron is a solid bounded by planes called faces, which meet in straight lines called 

edges. A regular polyhedron has all the faces equal and regular as shown in Fig. 3.2. 

Figure 3.2Regular Polyhedron 

 

Prism A prism is a polyhedron with two n-sided polygonal bases which are parallel and congruent, 

and lateral faces are rectangles. All cross-sections parallel to the bases are congruent with the 

bases. An imaginary line that joins the centre of the bases is called an axis. A right and regular 

prism has regular polygonal bases, axis perpendicular to the bases and all the faces are equal 



rectangles, as shown in Fig.3.3. Prisms are named according to the shape of their base, so a 
 

 

 

 
 

 
Figure 3.3Prisms 

 

Pyramid A pyramid is a polyhedron with n-sided polygonal base and lateral faces are triangles meeting 

at a point called the vertex or apex. An imaginary line that joins the apex with the centre of the 

base is known as the axis. A right and regular pyramid has a regular polygon base, axis 

perpendicular to the base and all the faces are equal isosceles triangles, as shown in Fig. 3.4. 

Pyramids are named according to the shape of their base, so a pyramid with a triangular base 

 
 

 

 
 

 
Figure 3.4Pyramids 



 
 

Solid of Revolution These solids are obtained by revolving a plane figure like rectangle, triangle or a semi-circle 

about a fixed line. 

Cylinder: A cylinder is a solid of revolution obtained by revolving a rectangle about one of its 

fixed side called an axis. It can be imagined as a prism of infinite number of lateral faces. Any 

line on the surface of a cylinder is called its generator. Thus, a cylinder has an infinite number 

of generators. A right cylinder has all the generators and the axis perpendicular to the base, as 

shown in Fig. 3.5(a). 

Cone:A cone is obtained by revolving a triangle about its fixed side called an axis. A cone can 

be imagined as a pyramid with infinite number of lateral faces. Any line on the surface of a 

cone is called its generator. Thus, a cone has an infinite number of generators. A right cone has 

all generators of equal length and the axis perpendicular to the base, as shown in Fig. 3.5(b). 

Sphere:A sphere is obtained by revolving a semi-circle around its diameter, as shown in Fig 

Figure 3.5Solids of Revolution 

 

 

Oblique Solid 

 
 



 

base as shown in Fig.3.6. The faces of an oblique prism are parallelograms of different sizes. 

The faces of an oblique pyramid are triangles of different sizes. The generators in an oblique 

cylinder have equal lengths whereas those in an oblique cone have unequal lengths. 

 

 
 
 

 
Figure 3.6Oblique Solids 

 

Frustum of Pyramid and Cone When a regular pyramid or a cone is cut by a plane parallel to its base and the 

portion of the 

solid containing apex is removed, the remaining portion of the solid is called the frustum of 



that pyramid or cone, as shown in Fig. 3.7. 
 

Figure 3.7Frustums 

 

 

Recommended Method of Labelling 

 
 

 

 

 
 
 

Figure 3.8Method of Labelling 

 

Positions of Solids 
 

The position of a solid in space is specified by the inclinations of its axis with the RPs. 

Therefore, a solid will have positions with respect to RPs same as that of a line. Depending on 

the orientation of its axis in space, a solid may have the following positions: 

Figure 3.9Truncated Solids 

 

The solid may be in one of the following positions: 
 

1. Axis perpendicular to the H.P. 
 

2. Axis perpendicular to the V.P. 
 

3. Axis parallel to both the H.P. and the V.P. (i.e., perpendicular to the profile plane) 
 

4. Axis inclined to the H.P. and parallel to the V.P. 



5. Axis inclined to the V.P. and parallel to the H.P. 
 

6. Axis inclined to both the H.P. and the V.P. 

 

 
 

 
Axis Perpendicular to H.P. 

 

This is one of the basic positions of the solid. It is evident that if the axis of a right solid is 

perpendicular to the H.P., its base will be parallel to the H.P. The true shape and size of the 

base can be viewed in the top view. Therefore, first obtain the top view of the solid and then 

project it to obtain the front view. 

 

 
 

 
Figure 3.10Axis Perpendicular to H.P. 



Axis Perpendicular to V.P. 
 

This is one of the basic positions of the solid. It is evident that if the axis of a right solid is 

perpendicular to the V.P., its base will be parallel to the V.P. The true shape and size of the 

base can be viewed in the front view. Therefore, first obtain the front view of the solid and then 

project it to obtain the top view. 

 

 
 
 

Figure 3.11Axis Perpendicular to V.P. 

 

Axis Parallel to both H.P. and V.P. 
 

It is evident that if the axis of right solids is parallel to both H.P. and V.P., the base of the solid 
 

will be perpendicular to the reference planes and parallel to the profile plane. The true shape and size of the base 

can be viewed in the side view. Therefore, first obtain the side view of the 

solid and then project it to obtain the front and the top views. 



 
 
 
 
 

Figure 3.12Axis Parallel to both H.P and V.P. 

 

Axis inclined to the R.P. and parallel to the R.P. 
 

If the axis of a solid is inclined to one RP and parallel to the other RP then the problem is solved 

in two stages. In the first stage, the axis is assumed to be perpendicular to the RP to which it is 

finally inclined. The view obtained on that RP will give the true shape of the base. The 

corresponding other view will give the TL of the axis. In the second stage, the other view is 

redrawn in such a way that the axis will make the required angle with the given RP. 

Here, it should be noted that the inclination of the axis with a particular RP might not be given 
 

 
 
 

Figure 3.13Axis inclined to the H.P. and parallel to the V.P. 



Figure 3.14Axis inclined to the V.P. and parallel to the H.P. 

 

Axis inclined to the both R.P ‘S. 
 

If the axis of a solid is inclined to both the RPs then the problem is solved in three stages. As 

already mentioned, the inclinations of the axes may not be given directly. Instead, it may be 

indirectly mentioned by means some other parameters. If the inclinations are given directly 

then, in the first stage, the axis is assumed to be perpendicular to any one RP. The view obtained 

on that RP will give the true shape of the base. The corresponding other view will give the TL 

of the axis. In the second stage, the other view is redrawn so that the axis will make the required 

angle with the RP to which it was initially perpendicular. The corresponding next view is 

obtained in the second stage. In the third stage, the next view is redrawn so as to make the 

‘desired inclination’ of the axis with the other RP. Here, the ‘desired inclination’ is the apparent 

inclination of the axis which is obtained by using the theory of projections of the lines. The 

view thus obtained satisfies all the conditions, i.e., inclinations with both the RPs, and hence 

represents the final view. This view is then projected to obtain the other corresponding final 

view. 

 
 
 
 

inclination of the axis with one RP is given and the inclination with the other RP is given in 

terms of the inclination of an edge or face of the solid. In such a case, the first stage is to keep 

the axis perpendicular to that RP with which its inclination is known. In the second stage, the 

required inclination with that RP is obtained. In the third stage, the other condition, viz., 

inclination of the face or inclination of an edge, is established. It must be remembered that, in 

the first stage, the solid is always kept in such a way that the true shape of the base and TL of 

the axis are visible. This helps to satisfy the condition on the axis (mentioned directly or indirectly) easily in the 

second stage. Note that one view in the second stage always gives TL 



of the axis (since it is simply redrawn from the first stage). 

Other possibilities are explained with the help of examples. 

 
 
 
 

Figure 3.15Axis inclined to the both R.P. 

 

Solved Problems 
 

1. A square prism 35 mm side of base and 60 mm axis length rests on HP on one of its edges 

of the base which is inclined to VP at 30º. Draw the projections of the prism when the axis 

 
 
 

 
is inclined to HP at 45º. Solution 

 

1. Open the Software. Click on the Application Menu and click on New and select “acad “in 

the open dialog box and click Open. 

2. Enter the command “UNITS “in command bar and Select units as “Millimeters and click 



 

 
 
 

 

3. Enter the command “LIMITS “in command bar and enter 0,0 click enter and enter upper 

right corner as 100,100 and click enter 

4. Enter the command “ZOOM “in command bar and enter A and click enter 
 

5. Draw a XY line by using line command. Mark VP and HP above and below it by using 

“XTEXT” command in command bar 

6. As per the problem draw a square lamina of 35 mm in HP using RECTANGLE command 

and in format select first corner and click enter and select Area, Now enter X size = 35, 

Y size = 35 and similarly label the bottom face as a1 b1 c1 d1 center as o1 using XTEXT 

Command 

7. Draw the horizontal line at a distance of 60 mm i.e., equal to height of the square prism 

above the XY line using LINE COMMAND and enter 60 in mini dialog box. Draw the 

vertical projection upwards from top view, until they intersect horizontal line at 60 mm 

above XY line using POLYLINE command. Mark the intersection points as a' b' c' d' and 

o' for the top face and a1' b1' c1' d1' and o1' for bottom of the square prism. 
 

8. Since the square prism axis is inclined at 45° to HP. By using POLYLINE command and 

in format select PL enter length equal to length (60) of first stage front view and angle as 

45 in mini dialog box draw a line of 45°. Mark the annotations as shown below. 
 

9. Draw vertical projectors downwards from the second stage front view using POLYLINE 

command and in format select PL. Draw horizontal projectors from top view to intersect 



vertical projectors to get required second stage top view by joining intersection points by using LINE Command 

and in format select VL as shown below. Note the invisible (hidden) 

lines are to be dotted. Hence draw invisible line using POLYLINE command and in format 

select DL. 

 
 

 
10. Since the edge on which prism rests is inclined to VP at 30°. Draw a line of 30° in HP 

using POLYLINE command and in format select PL. Mark annotations as shown below. 

 



11. Draw the vertical projection upwards from the third stage top view using POLYLINE 

command and in format select PL. Again, draw horizontal projectors from second stage 

front view to intersect vertical projectors to get the final front view. Join all the intersection 

points using LINE Command and in format select VL. 

12. Using DIMENSION Command in Annotation tool bar or Enter DIM command in 

command bar dimension the drawing 

 

 
 
 

2. A hexagonal prism 25 mm sides of base and 50 mm axis length rests on HP on one of its 

corners of the base such that the two base edges containing the corner on which it rests 

make equal inclinations with HP. Draw the projections of the prism when the axis of the 

prism is inclined to HP at 40º and to VP at 30º. 



 
 
 
 

1. Open the Software. Click on the Application Menu and click on New and select “acad “in 

the open dialog box and click Open. 

2. Enter the command “UNITS “in command bar and Select units as “Millimeters and click 

ok. 

3. Enter the command “LIMITS “in command bar and enter 0,0 click enter and enter upper 

right corner as 100,100 and click enter 

4. Enter the command “ZOOM “in command bar and enter A and click enter 

 
 

 
 

 
“XTEXT” command in command bar 



6. As per the problem draw a hexagonal lamina of 25 mm in HP using POLYLINE command 

and in format select VL and enter edges as 6, radius as 25. Mark the corner points of top 

face as a b c d e f and center as o. Similarly label the bottom face as a1 b1 c1 d1 e1 f1 center 

as o1 using XTEXT Command 

7. Draw the horizontal line at a distance of 50 mm i.e., equal to height of the hexagonal prism 

above the XY line using PARALLEL LINE COMMAND and enter 50 in mini dialog box. 

Draw the vertical projection upwards from top view, until they intersect horizontal line at 

50 mm above XY line using POLYLINE command. Mark the intersection points as a' b' c' 

d' e' f' and o' for the top face and a1' b1' c1' d1' e1' f1' and o1' for bottom of the square prism. 
 

8. Since the hexagonal prism axis is inclined at 40° to HP. By using POLYLINE command 

and in format select PL enter length equal to length (50) of first stage front view and angle 

as 40 in mini dialog box to draw a line of 40°. Mark the annotations as shown below. 

9. Draw vertical projectors downwards from the second stage front view using POLYLINE 

command and in format select PL. Draw horizontal projectors from top view to intersect 

vertical projectors to get required second stage top view by joining intersection points by 

using LINE Command and in format select VL as shown below. Note the invisible (hidden) lines are to be dotted. 

Hence draw invisible line using POLYLINE command and in format 

select DL. 

 
 
 
 

10. As per the problem draw a line of 30° in HP using POLYLINE command and in format 

select PL. Draw an arc of radius equal to axis of prism from first stage front view to cut on 



30° line drawn. Draw a locus from point o1, now with radius equal to axis of prism from 

second stage top view to cut on the locus. Join o o1 to get the axis of third stage top view. 

11. Draw the vertical projection upwards from the third stage top view using POLYLINE 

command and in format select PL. Again, draw horizontal projectors from second stage 

front view to intersect vertical projectors to get the final front view. Join all the intersection 

points using LINE Command and in format select VL and draw invisible line using 

POLYLINE command and in format select DL. 

 
 
 
 

12. Using DIMENSION Command in Annotation tool bar or Enter DIM command in command 

bar dimension the drawing Practice Problems 

1. A Square Pyramid, having base with a 40mm side and 60mm axis is resting on its base on 

the HP. Draw its Projections when 

(a) A side of the base is parallel to the VP. 
 

(b) A side of the base is inclined at 300to the VP and 
 

(c) All the sides of base are equally inclined to the VP 
 

2. A pentagonal Prism having a base with 30 mm side and 60 mm long Axis, has one of Its 

bases in the VP. Draw Its projections When 

(a) Rectangular face is parallel to and 15 mm above the HP 



 

 
 
 
 

(b) A rectangular face perpendicular to HP and 
 

(c) A rectangular face is inclined at 450 to the HP 
 

3. A pentagonal Prism having a base with a 30 mm side and 60 mm long axis, is resting on 

one of its rectangular faces on the HP. with axis parallel to the VP. Draw its projections? 

4. A hexagonal Prism having a base with a 30 mm side and 75 mm long axis, has an edge its 

base on the HP, its axis parallel to the VP and inclined at 450 to the HP. Draw its 

projections? 
 

5. A hexagonal Prism having a base with a 30 mm side and 65 mm long axis, has an edge its 

base on the VP, its axis parallel to the HP and inclined at 300 to the VP. Draw its 

projections? 
 

6. A cube of 50 mm long edges is so placed on HP on one corner that a body diagonal is 
 

Parallel to HP and perpendicular to VP. Draw its projections. 7. A cone 40 mm diameter and 50 mm axis are 

resting on one of its generators on HP which 

makes 300inclinations with VP. Draw its projections. 
 

8. A circular cone, 40 mm base diameter and 60 mm long axis is resting on HP, on one point 

of base circle such that its axis makes 450inclination with HP and 400inclination with VP. 

Draw its projections. 

9. A cylinder 40 mm base diameter and 50 mm long axis is resting on one point of base circle 



 
 

 
 
 

 

 
 

Isometric Projection 

In engineering drawing, orthographic projection of a solid is best way of projecting the details of an object when a 

solid is resting in its simple position. As the front view or top view taken separately, gives an incomplete idea of 

the object, a pictorial projection is the best method to show the object in one view only. Basically, pictorial 

projection represents three dimensional shape of an object and represents real things in one view only, which 

indicates length, breadth and height of the object. Therefore, the object is easily visualized from a pictorial 

projection than from its orthographic projection. 

The pictorial projection may be divided as: 1. Oblique projection 2. Perspective projection 3. Axonometric 

projection. 



 

 
 
 
 

Axonometric Projection An axonometric projection is a type of single-view parallel projection used to create a 

pictorial drawing of an object. The object is placed in such a position that the three mutually perpendicular faces 

are visible from a single direction. The word ‘axonometric projection’ means measuring along axis in which “axon” 

means axis while metron means measuring. Axonometric projections are commonly used to draw mechanical 

parts of an object for the clear picture of an object which are visualized from the orthographic projection. In this 

projection the object can be drawn at different angles and having the different length of edges. 

Axonometric projections are again classified as: Trimetric Projection In this type, an object is placed in such a 

way that no two axes make an equal angle with the plane of projection. 

Dimetric Projection In this type of projection, an object is placed in such a way that two of its axes make equal 

angle with the plane of projection and the third axis makes either a smaller or a greater angle. 

Isometric Projection In this type of projection, an object is placed in such a way that all three axes make equal 

angle with the plane of projection. 

The isometric projection is the most common pictorial representation used in industries where visualization of the 

three dimensions of a solid are not only shown in one view, but their actual sizes can be measured directly from 

it. As it shows views of three faces of an object equally, it is very helpful to even a layman to understand the 

shape of the object. A multiview drawing requires two or more orthographic projections to define the exact shape 

of a three dimensional object. Each orthographic view is a two-dimensional drawing showing only two out of three 

dimensions of the object. 

 

 

 
 
 

edges of the cube. 



a. They make equal angles of 120° with each other. 
 

b. They are equal in length but smaller than the true length of the edge of the cube. 
 

c. The line CG is vertical, and the other lines CB and CD make 30° with the horizontal. 4. All other lines 

representing the edges of the cube are parallel to one or the other of the above 

three lines, i.e., CB, CD and CG, and are equally foreshortened. 5. The diagonal BD of the top face ABCD is 

parallel to V.P., and hence shows its true length. 

A comparison of the rhombus ABCD of the front view with the square face of the cube is shown in below figure. 

Isometric Axes, Lines and Planes 1. The three lines CB, CD, CG meeting at a point C and making an angle of 

1200with each 

other are called Isometric axes. 2. The lines (AB, BF, FG, GH, DH and AD) parallel to the Isometric axis are 

termed as 

Isometric lines. 3. The lines (BD, AC, CF, BG, etc.,) which are not parallel to the isometric axes are known 
 

as Non-Isometric lines 4. The plane (ABCD, BCGF, CGHD, etc.,) representing any face of the cube as well as 

other 

plane parallel to it is called an Isometric Plane. 5. The plane (ABGH, CDEF, AFH, CFH, etc.,) which is not 

parallel to isometric planes are 

known as Non-Isometric Planes. 6. The scale which is used to convert the true length into isometric length is 

known as 

Isometric Scale. 
 

Isometric Scale Referring to the above Fig., all the edges of the cube are equally foreshortened. Therefore, the 

square faces are seen as rhombuses in the isometric projection. The foreshortening of the edge can be 

calculated as follows: 
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Conventional Isometric Scale Simplified Isometric Scale 

 

This reduction of the true length can be obtained either by multiplying it by a factor 0.816 or by taking the 

measurement with the help of an isometric scale. 

Isometric Projection and View 

 
 
 

 
 
 

(a) Multiview projection (b) Isometric projection (c) isometric view 

 

Dimensioning The general rules for the dimensioning of multi view projection is applicable for isometric 

projection, except the following: 

1. All the extension lines and dimension lines should be parallel to the isometric axes and 



 

 
 

 
 

 
they should be on any of the isometric planes. 

 

2. The text should be placed at the middle of the dimension line, after breaking it to a short 

length. 

3. The dimensional values in X direction should be readable from the right side. While the 

Y direction from left side and Z direction from the right side respectively. 

4. The numerals placed along the three axes should be aligned with the direction of the 



axes. System of Notation 
 

 

 
 
 

solid and A, B, C and D etc for top face of the solid and axis as o1 and o. 2. The front view (FV) of a solid is 

denoted by their corresponding lower case letters with 

dashes as a1', b1', c1'and d1'etc for base of solid and a', b'c'and d'etc for top face of the 
 

solid and for axis as o1'and o'. 3. The top view (TV) of a solid is denoted by their corresponding lower case letters 

with 

dashes as a1, b1, c1 and d1 etc for bottom of solid and a, b c and d etc for top face of the 
 

solid and for axis as o1 and o. 4. Projectors are always drawn as continuous thin lines. 5. Isometric projection 

annotations are made with the corresponding letters of the solid. 6. Line with specific thickness for a particular 

type of line. 

Isometric Drawing using AutoCAD In Computer Aided Engineering Graphics for isometric projections following 

commands are 



 
 
 
 

 

 
 
 
 
 

 
By using the ISODRAFT command, several system variables and settings are automatically changed to values 

that facilitate isometric angles. Isoplane specifies the current isometric plane. The standard isometric planes, 

calledisoplanes, are as follows: 

• Right.: Selects the right-hand plane, defined by the 30- and 90-degree axes pair 
 

• Left: Selects the left-hand plane, defined by the 90- and 150-degree axes pair. 
 

• Top: Selects the top face, called the top plane, defined by the 30- and 150-degree axis 

pair. 

You can use the Isometric Drafting tool on the status bar to select the desired isoplane. Alternatively, you can 

press F5 or Ctrl+E to cycles through the isoplanes. Using these following commands and features are the most 

commonly used ones to maintain precision in isometric drawings: 

• Polar tracking and direct distance entry 
 

• Object snaps and grid snaps 
 

• Object snap tracking 



• Move and Copy 
 

Extrude The EXTRUDE command creates a solid or surface that extends the shape of a curve. Open curves 

create surfaces and closed curves create solids or surfaces When you extrude objects, you can specify any of 

the following options: 

Mode. Sets whether the extrude creates a surface or a solid. Specify a path for extrusion.With the Path option, 

create a solid or surface by specifying an object to be the path for the profile, or shape, of the extrusion. The 

extruded object starts from the plane of the profile and ends on a plane perpendicular to the path at the endpoint 

of the path. For best results, use object snaps to make sure that the path is on or within the boundary of the 

object being extruded. 

Taper angle. Tapering the extrusion is useful for defining part that require a specific taper angle, such as a mold 

used to create metal products in a foundry. 

Direction. With the Direction option, you can specify two points to set the length and direction of the extrusion. 
 

Expression. Enter a mathematical expression to constrain the height of the extrusion. 
 

Revolve Open profiles create surfaces and closed profiles can create either a solid or a surface. The MOde 

option controls is a solid of surface is created. When creating a surface, SURFACEMODELINGMODE system 

variable controls if a procedural or NURBS surface is created. Revolve path and profile curves can be: 

• Open or closed 
 

• Planar or non-planar 
 

• Solid and surface edges 
 

• A single object (to extrude multiple lines, convert them to a single object with the JOIN 

command) 

• A single region (to extrude multiple regions, first convert them to a single object with 

the UNION command) The following are the options for revolving: 

Objects to Revolve Specifies the objects to be revolved about an axis. Mode Controls whether the revolve 

action creates a solid or a surface. Surfaces are extended as either NURBS surfaces or procedural surfaces, 

depending on the SURFACEMODELINGMODE system variable. Axis Start Point Specifies the first point of the 

axis of revolution. The positive axis direction is from the first to the second point. 

Axis Endpoint Sets the endpoint for the axis of revolution. 
 

Start Angle Specifies an offset for the revolution from the plane of the object being revolved. 
 

Angle of Revolution Specifies how far the selected object revolves about the axis. 
 

Loft Creates a 3D solid or surface by specifying a series of cross sections. The cross sections define the shape 

of the resulting solid or surface. Loft cross sections can be open or closed, planar or non-planar, and can also be 

edge subobjects. Open cross sections create surfaces and closed cross sections create solids or surfaces, 

depending on the specified mode. 

The following prompts are used under loft: 
 

Cross Sections in Lofting Order Specifies open or closed curves in the order in which the surface or solid will 

pass through them. 

Point Specifies first or last point of the lofting operation. If you start with the Point option, you must next select a 

closed curve. 

Join Multiple Edges Handles multiple, end-to-end edges as one cross section. 
 

Mode Controls whether the lofted object is a solid or a surface. 



Continuity This option only displays if the LOFTNORMALS system variable is set to 1 (smooth fit). Specifies 

whether the continuity is G0, G1, or G2 where the surfaces meet. 

Bulge Magnitude This option only displays if the LOFTNORMALS system variable is set to 1 (smooth fit). 

Specifies a bulge magnitude value for objects that have a continuity of G1 or G2. 

Guides Specifies guide curves that control the shape of the lofted solid or surface. Guide curves can be used to 

control how points are matched up on corresponding cross sections to prevent undesired results, such as 

wrinkles in the resulting solid or surface. Problem: 1. Draw the isometric view of a Circle (Isocircle) with a 60mm 

Diameter on all three Principle Planes Using Co-ordinate methods? 

Solution: 1. Do one of the following: 
 

• On the status bar, click Find. 
 

 
 
 

• At the Command prompt, enter ISODRAFT. 2. Choose which isoplane orientation that you want to use: Left, 

Right, or Top. 

• Press F5 or Ctrl+E to cycle through the different isoplanes 

 
 
 

 
 

 
• On the status bar, Isodraft button, click the dropdown arrow and choose an option 

 

• At the Isodraft prompt in the Command window, enter an option 3. At the Command prompt, enter ELLIPSE. 4. 

At prompt, enter i (Isocircle). 5. The Isocircle option is available only when an isometric drawing plane is active. 6. 

Specify the center of the isocircle. 7. Specify the radius or diameter of the isocircle. 

2. Draw the isometric view of a square of side 40mm kept in (a) vertical Position and (b) horizontal position 
 

Solution: 1. Do one of the following: 
 

• On the status bar, click Find. 
 

 
 
 

• At the Command prompt, enter ISODRAFT. 2. Choose which isoplane orientation that you want to use: Left, 

Right, or Top. 



• Press F5 or Ctrl+E to cycle through the different isoplanes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• On the status bar, Isodraft button, click the dropdown arrow and choose an option 
 

• At the Isodraft prompt in the Command window, enter an option 3. At the Command prompt, enter Line. 4. The 

Polyline option is available only when an isometric drawing plane is active. 5. Specify the coordinates of the 

square to draw the square. 3. Draw the isometric view of a square prism of base side 40 mm and axis 60 mm 

resting on the H.P. on the (a) base with axis perpendicular to the H.P., (b) rectangular face with axis 

perpendicular to the V.P., and (c) rectangular face with axis parallel to the V.P. 

 

 
 
 

Solution: 1. At first, you need to change your snap settings to isometric. Type DS on the command 
 

line and press enter. 2. Drafting settings window will pop up from this window select snap and grid tab and 

make sure Isometric snap radio button is checked. Click OK to exit drafting settings 

window. 3. Now make sure ortho mode is turned on from the status bar, if it is not turned on then 
 

press F8 to turn it on. 4. You can now select isometric plane for your drawing by pressing the F5 key. The three 
 

Isoplanes available for selection are Isoplane top, right and left. 5. Press F5 key to activate Isoplane top and then 

select line command and click anywhere 

in the drawing area to start your line. Specify a direction and type 5 on the command 



line then press enter, repeat this process by changing directions of line to make a closed 

square 

4. A of cone base diameter 30mm and height 40mm rests centrally over a cube of side 50mm. Draw the isometric 

projection of combination of solids. 

 

 

 
 
 

Solution: 1. Open the SOFTWARE. Click on the DRAWING in the open dialog box and say OK. 2. To set up the 

sheet of required size (Ex: A4) by selecting TOOLS from Main Menu Bar 

and click on OPTIONS/PROPERTIES. Select document properties in dialog box 

appeared and then select drawing in selection panel. Select the required size say A4, 

and click OK. 3. As per the problem draw top and front view of combined solids using suitable commands. 

 

 
 

 
prism of 50 mm using POLYLINE command and in format select VL. 



6. Join all the top end points using 2 POINT LINE Command and in format select PL to get top face as shown 

below. 

 7. Since the axis of solids is collinear (square prism and cone), identify the center of rectangle represent it as o. 

With o as center construct a box of iso length of side 30 mm similar to base drawn earlier as shown using 

POLYLINE command and in format select PL. 

 8. Using 3 POINT CIRCLE command in drafting tool bar. In mode option select arc, and use three center method 

draw an ellipse to get the bottom of cone.  

9. Using POLYLINE command and in format select AL draw vertical line upwards at the center of rectangle, 

equal to the height of cone 40 mm (given) to get apex of the cone. 10. Using POLYLINE command and in format 

select VL draw tangential line from bottom of cone to apex as shown. Trim all the unwanted construction lines by 

using SMART DELETE COMMAND. 11. Using SMART DIMENSION Command in drawing tool bar dimension 

the drawing as shown. To get a Hard Copy of the standard drawing select print from file menu bar. Print dialog 

window will appear select page and change width to Entities and select the activated button now substitute width 

1 as 0.15 mm, width 2 as 0.05 mm, width 3 as 0.5 mm, width 4 as 0.35 mm and say OK. Select print to get a hard 

copy and finally save the file. The required standard drawing is as shown below. 

5. A hemisphere diameter 50mm is resting on its curved surface centrally on the top face of frustum of a 

rectangular pyramid base 80mm x 60mm and top 60mm x 40mm, height 55mm. Draw the isometric projection of 

combined solids. Solution: 1. Open the SOFTWARE. Click on the DRAWINGin the open dialog box and say OK. 

2. To set up the sheet of required size (Ex: A4) by selecting TOOLSfrom Main Menu Bar and click on 

OPTIONS/PROPERTIES. Select document properties in dialog box appeared and then select drawing in 

selection panel. Select the required size say A4, and click OK. 3. As per the problem draw top and front view of 

combined solids using suitable commands. 4. Draw the isometric scale, as per the dimensions of the problem. 5. 

Using POLYLINEcommand and in format select VL for visible edges draw two lines of iso length of 80 mm and 

60 mm along 30° line as shown. Draw another two lines, using PARALLEL LINE COMMANDand using 

TRIM/EXTEND CURVESso that, they are connected systematically. 6. Using POLYLINE command and in format 

select AL draw vertical line upwards at the 

center of rectangle, equal to the height of rectangular frustum 55 mm (given). 
 

7. At top end of vertical line drawn, using POLYLINE command and in format select VL for visible edges draw two 

lines of iso length of 60 mm and 40 mm along 30° line as shown. Draw another two lines, using PARALLEL LINE 

COMMAND and using 

TRIM/EXTEND CURVES so that, they are connected systematically. 
 

8. Join all the relevant corners of top to base frustum using 2 POINT LINE command and in format select VL to 

get frustum as shown below. 9. Since the axis of solids is collinear (hemisphere and rectangular pyramid), identify 

the center of rectangle represent it as o. With o as center using POLYLINE command and in format select AL 

draw vertical line upwards at the center o of height equal to height of hemisphere 25 mm (given). Construct a box 

of iso length of side 50 mm to fit top 

face of hemisphere using POLYLINE command and in format select PL. 
 

10. Using 3 POINT CIRCLE command in drafting tool bar. In mode option select arc, and select 3 points on 

rectangle draw a top face of hemisphere. 11. Using CENTER CIRCLE command in drafting tool bar. In mode 

option select arc, with center as center of top face of hemisphere and radius as actual radius of hemisphere draw 

an arc, so that it touches the top face of hemisphere and passes through the center of top face of the rectangle 

frustum. 12. Trim all the unwanted construction lines by using SMART DELETE COMMAND. Using SMART 

DIMENSION command in drawing tool bar dimension the drawing as shown. To get a Hard Copy of the standard 

drawing select print from file menu bar. Print dialog window will appear select page and change width to Entities 

and select the activated button now substitute width 1 as 0.15 mm, width 2 as 0.05 mm, width 3 as 0.5 mm, width 

4 as 0.35 mm and say OK. Select print to get a hard copy and finally save the file. The required standard drawing 

is as shown below. Practice Exercises: 

Plane Surface 1. Draw the isometric view of a hexagon of side 30 mm whose surface is parallel to the V.P. 
 

and a side perpendicular to the H.P. 2. Draw isometric views of a triangle of sides 80 mm, 60 mm and 50 mm on 

all the three 

principal planes. 3. Draw the isometric view of a cube of side 50 mm. Also show in the view, circles of diameter 
 

50 mm marked on all the visible faces of the cube. 4. Draw isometric view of a hexagonal plane of side 40 mm 

with a central hole of diameter 



40 mm when the surface of the plane is parallel to the H.P. 5. Draw isometric view of a composite plane made up 

of a rectangle of sides 60 mm and 40 

mm with a semicircle on its longer side. 
 

Simple Solid 1. Draw the isometric view of a cylinder of base diameter 50 mm and axis 60 mm lying on 
 

one of its generator on the H.P 2. A square prism of base edge 40 mm and axis 60 mm has an edge of its base 

on the H.P. The 

axis is parallel to the V.P. and inclined at 30° to the H.P. Draw its isometric view 3. Draw an isometric view of a 

pentagonal prism of base side 30 mm and axis 60 mm resting 

on its base in the H.P. with a face parallel and nearer to the V.P. 4. A pentagonal pyramid of base side 30 mm and 

axis 60 mm long is resting on a face on the 

H.P. with axis parallel to the V.P. Draw its isometric view in the stated condition. 
 

Truncated Prism 1. Draw isometric projection of the frustum of a pentagonal pyramid of base side 40 mm, top 
 

side 20 mm and height 35 mm resting on its base on the H.P 2. A triangular pyramid having a base 50 mm side 

and axis 65 mm long is resting on its base 

in the H.P. with a side of the base parallel to the V.P. It is cut by an A.I.P. inclined at 45° 
 

with the H.P. and bisecting the axis. Draw its isometric view 3. A paper weight is in the form of a sphere of 

diameter 50 mm truncated by a horizontal plane 

at a distance of 40 mm from the topmost point of the sphere. Draw its isometric projection. 
 

Combined Solids 1. A cone of base diameter 30 mm and axis 50 mm rests centrally over a square prism of base 
 

side 50 mm and axis 30 mm. Draw the isometric projection of the arrangement 2. A spherical ball of diameter 60 

mm is placed centrally over a square block of side 60 mm 

and thickness 30 mm. Draw the isometric view of the arrangement 3. A hexagonal prism of base side 30 mm and 

axis 50 mm has an axially drilled circular hole 

of diameter 30 mm. Draw its isometric projection. 
 



 


